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1. 結合の有無の確認、スクリーニング 

1-1. プログラムの実行 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run → Wizard をクリックしま

す。 

 

Assay → Binding Analysis を選択した後、New をクリックします。以前にプログラムを

Methods and Templates フォルダに保存している場合は、右側の一覧表に反映されます。同

じプログラムを実行したい場合は、Open をクリックします。別のフォルダに保存されてい

るプログラムを実行したい場合は、Browse をクリックし、目的のプログラムをハイライト

にして Open をクリックします。なお、低分子化合物のスクリーニングやキャプチャー法で

キャプチャー分子が複数種類ある場合には、メソッドを利用します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 サイクル分の測定シークエンスを設定します。 
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Detection 

Flow path  目的のフローセルを設定します。 

リファレンスの差し引き機能を利用してください。キャ

プチャー法を利用する場合、差し引き機能として 2-1 ま

たは 4-3 のみの選択となります。 

Chip    

 Chip type   利用するセンサーチップを選択します。 

 

Capture 

アナライトの添加前に、固定化したキャプチャー分子に対して、リガンドを捕捉

する場合にチェックを入れます。リガンドは、フローセル 2 もしくはフローセル 4

にキャプチャーされます。 

Sample 

アナライトの添加。複数サンプルの連続添加は、補足 1-1 を参照してください。 

Enhancement 

2 次抗体などを添加する場合にチェックを入れます。 

Regeneration 

再生が必要な場合にチェックを入れます。添加回数を選択します。（1 or 2） 

 

入力後、Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

ダミーランサイクルを設定します。 

Startup 

Solution  指定した溶液で、相互作用測定と同様の工程をアナラ

イト測定前に実施します。通常は、ランニング緩衝液を

用います。 

Number of cycles サイクル数。3 回以上を推奨します。 
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Next をクリックします。 

↓ 

補足 1-1. 複数サンプルの連続添加 

エピトープマッピング等多段階の相互作用を検証する場合は、Sample 右のカラムで添加サ

ンプル数を選択します。最大 4 サンプルまでの添加が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

サンプル 1 

サンプル 2 

サンプル 3 
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Sample 

contact time  アナライトの添加時間（s） 

Flow rate   流速（μl/min） 

Dissociation time  解離時間（s） 

Regeneration 

Solution   再生溶液の名称 

High viscosity solution 粘性の高い溶液（40% エチレングリコール以上）の場

合は選択します 

contact time  再生溶液の添加時間（s） 

Flow rate   流速（μl/min） 

Stabilization period 添加後のベースラインの安定化時間（s） 

設定後、Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

Sample id アナライトの名称を入力します。入力した順番で測定します。 

コントロールサンプルを定期的に添加する場合は、Control Samples をクリックします。 
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Repeat Control Sample(s) every 何サンプル毎にコントロールサンプルを測定するか入 

    力します。入力後、OK をクリックします。 

ポジティブコントロール、ネガティブコントロールを使用した各種補正を行う場合には、

必ずコントロールサンプルを定期的に測定してください。 

Next をクリックします。 

 

補足 1-2. Excel ファイルで作成したサンプル情報の入力 

Excel ファイルで作成したサンプル情報を移行するには、Excel での保存時、タブ区切りのテ

キストファイル（拡張子は txt）を選択します。タブ区切りで保存したデータを上記画面で

開き、コピーペーストで入力してください。 

 

↓ 

 

 

 

 

 

 

 

測定を始める前の Prime および Normalize の実施を選択します。 

Analysis temperature   25℃ 
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Sample compartment temperature  25℃

サイクルの測定順番を確認したい場合には、Cycle Run List をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 
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補足 1-3. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu → Export Positions

を実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を

変更した後ファイルを保存し、Menu → Sample Position Import でそのファイルを読み込む

と、サンプル位置が変更されます。 

 

補足 1-4. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分注して配置されるように組ま

れている（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに分

けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合はプ

ーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 
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ここで、すべてのサンプルと試薬に関する配置設定を行うことができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。 

 

Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。 

Eject Rack Tray ダイアログが閉じた後、Rack Positions ダイアログ右下の Next をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。
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↓ 

 

 

 

 

 

 

 

 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

が開始します。 

 ↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動して、各サイクルの測定結果が重ね書き表示されます。 

 

補足 1-5. プログラムの緊急停止 

Run → Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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1-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行されます。 

 

補足 1-6. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 1-7. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

 

Sensorgram window 
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複数の測定データファイルの同時解析 

同一条件で測定した、複数の測定データを一括して解析したい場合には、解析前に全ての

解析したいデータファイルを呼び込みます。最大 5,000 サンプル（1 濃度シリーズ, data 

correction rate;1Hz）を同時に解析できます。 

File > Append Result File を選択後、追加したいファイル名を選択します。この操作を繰り

返してデータの追加を行います。溶媒補正が必要な場合には、すべてのデータを呼び込ん

だ後に、Solvent Correction を実施します。 

 

プロットを使用した Quality Control（QC） 

解析用プロット（Result Plot）作成前に、自動作成された Plot または作成した QC Plot を使

用して解析に持ち込むデータの選択を行います。乱れているデータや、解析に持ち込まな

いデータの選択を行うことができます。この段階で Exclude したデータは、Result Plot には

持ち込まれません。 

 

画面左の Plot フォルダ内に、各種 Plot があります。自動取得されたレポートポイントでプ

ロットが作成されます。（測定条件によって内容は異なります。） 

（例） 

 

 

各 Plot を確認して、乱れがあるプロットや解析に持ち込まないプロットを確認します。 

 

 

 

 

 

 

 

 

：ベースライン変動 

：“binding”のプロット 

：“stability”のプロット 

：リファレンスセルでの“stability”のプロット 

：キャリーオーバーチェックの“co_binding”のプロット 

：コントロールサンプルの“binding”のプロット 

：コントロールサンプルの“stability”のプロット 
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各 Plot の表示方法について Binding level の Plot で紹介します。 

 

データの選択 

プロット上部の の もしくは をクリックし、評価したいデー

タを選択します。 

で 、 Assay Step で デ ー タ の 抽 出 が で き ま す 。

で、表示したいサンプルを個別に選択することができます。 

プロットのポイントにマウスを移動すると、サンプル情報を確認できます。 

 

プロットの並べ替え 

右側のテーブルの をクリックします。カラムタイトルが、 に変更さ

れ、結合レスポンスが低い順に並べ替えられます。 

引き続き、 をクリックすると、カラムタイトルは に変更され、高

い順に並びます。 
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ポイントの色の変更 

ポイントの色を変更したい場合には、右 Table 上部の をクリックします。 

Color By で変更方法を選択します。

 

 

センサーグラムの表示 

ポイント上にマウスのポインターを移動して、マウスを右クリックして Show Sensorgram

をクリックします。Y軸=0に補正したセンサーグラムとレポートポイントが表示されます。

複数のセンサーグラムを表示したい場合には、Table で該当のサンプルを選択後、マウス右

クリック、Show Sensorgrame (S)をクリックします。 

 

ポイントの削除 

除きたいポイントがある場合には、ポイント上にマウスポインターを移動後、マウスの右

クリック、Exclude Cycle をクリックします。ポイントがプロットから消え、画面右の Table

の該当サンプルが赤字に変わります。再度プロットに入れる場合には、Table の該当サンプ

ルを選択後、マウス右クリック、Include Cycle(s)を選択します。 

自動作成された Plot および QC Plot で Exclude したサンプルは、Result Plot には持ち込まれ

ません。 
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なお、別途 Plot を作成したい場合や、分子量補正やキャプチャー量補正を行った Plot を作

成したい場合には、新たに QC Plot を作成します。（分子量補正、キャプチャー量補正は、

Result Plot でも行えます。） 

 

新たに QC Plot を作成する際には、Plot→QC Plot を選択します。 

 

↓ 

Plot nameにプロット名を入力して、Y-Axis、X-Axisをプルダウンメニューから選択します。 

 

Finish をクリックします。画面左の Plot フォルダ内に QC Plot が追加されます。 

 

分子量補正、キャプチャー量補正 

 

Binding level のプロットで分子量補正を行いたい場合には、 の Molecular Weight 
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Adjustment を選択してください。（あらかじめ、Keyword Table に分子量が入力されている

必要があります。）プロットの Y 軸の単位は、100 × RU / Da に変わります。 

キャプチャー法を使用している場合には、 の Capture Adjustment を使用すると、

キャプチャー量で分子量を補正したプロットが作成されます。 

（いずれの補正もプロットのポイントに適用されますが、センサーグラムには適用されま

せん。） 

↓ 

次に、解析用の Result Plot を作成します。Plot の Result Plot をクリックします。 

 

↓ 

作成したいプロットの指定を行います。 

 

Plot name にプロット名を入力します。Y-Axis、X-Axis と Curves の選択を行います。 

Next をクリックします。 

↓ 

Result Plot ウインドウが開きます。 
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Report Point Adjustment タブで各種データ補正を選択します。上から順番に補正を実行す

ると、前の補正が適用された上で次の補正を適用することができます。 

 

Blank Subtraction 

ブランクの差し引きを行います。ネガティブコントロール、または、サンプルのゼロ濃度

がブランクとして認識されます。 

 

Blank Subtraction をクリックします。Use Blank Subtraction にチェックを入れます。 

Blank sample name をプルダウンメニューから選択します。ネガティブコントロール、また

は、サンプルのゼロ濃度（Sample Conc=0）から選択します。 
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差し引き方法を Subtraction settings のプルダウンメニューから選択します。 

Nearest Blank:  最も近いブランク 

Average Nearest Blanks:  サンプル測定前後の最も近いブランク 2 点の平均値 

   サンプル測定前または後にブランクがない場合には、最も近い

   ブランクを使用します。 

Preceding Blank:  サンプル測定前の最も近いブランク 

   サンプル測定前にブランクがない場合には、最も近いブランク

   を使用します。 

Following Blank:  サンプル測定後の最も近いブランク 

   サンプル測定後にブランクがない場合には、最も近いブランク

   を使用します。 

 

Molecular Weight Adjustment 

分子量補正を行います。化合物スクリーニングで有効です。補正式は次の通りです。 

100 × レスポンス（RU）/ 分子量（Da） 

Keyword Table で分子量が入力されていないものや、ゼロと入力されている場合には、プロ

ットから除外されます。 

補正後は、プロットの Y 軸の単位が、100 × RU / Da に変わります。 
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Capture Adjustment 

リガンドのキャプチャーを行ったデータで使用できます。次の式を使用します。 

レスポンス（RU）/ リガンドのキャプチャー量（RU） 

キャプチャー量は、レポートポイントの baselineから Capture_baselineを差し引いた値です。 

 

Adjustment For Controls 

コントロールの結合量を利用した補正方法です。再生条件が強くリガンドの結合活性がア

ッセイ中に低下している場合や、リガンドが時間経過とともに失活している場合に使用し

ます。リガンドの結合活性低下を、定期的に測定したコントロールサンプルの結合量を利

用して補正を行います。 

 

Adjustment For Controls をクリックします。 

Use adjustment for controls にチェックを入れます。 

 

Positive control および Negative control をプルダウンメニューから選択します。 

ネガティブコントロールを取っていない場合には、[None]を選択するとネガティブコントロ

ールとしてゼロを使用します。（Set zero level で値を変更することもできます。） 

スタートアップサイクルは自動的にプロットから排除されます。 

 

Fitting function で、Fitting 方法を選択します。 
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Linear:  Y = aX + b（a および b は定数）を使用します。 

Polynomial: Y = aX2 + bX + c（a、b および c は定数）を使用します。 

  コントロールサンプルのポイントが 4 つ以上必要です。 

 

Fitting 結果が、右のプロットに表示されます。赤色ライン：ポジティブコントロール、青色

ライン：ネガティブコントロールで、赤色ラインが Y = 100、青色ラインが Y = 0 になるよう

に計算を行います。同時に各ポイントが補正されます。 

 

OK をクリックします。 

 

 

Median Filtering 

メジアンフィルターを適用することで、結合レスポンスに影響を与えることなく、ノイズ

を低減して、プロットのドリフトを排除することができます。プロットがドリフトしてい

る場合や、周期的にベースラインが変動している場合に有効です。 

 

水平な Y 軸ウインドウと、スライドする X 軸ウインドウ（サイクル）の中央値でデータポ

イントの補正を設定します。Y 軸ウインドウの設定では、推定される non-binder が含まれ、

potential binder を除いた範囲に設定します。中央値は、各 X 軸ウインドウ内で、Y 軸ウイン

ドウ内の中間に位置するポイントの Y 軸の値を取ります。 
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各 X 軸ウインドウの中央値を Y = 0 として、ベースラインを作成します。プロットの各ポイ

ントから、各サイクルについて算出された中央値を差し引いて補正を行います。ファイル

を複数呼び込んでいる場合には、各ファイルのデータを 1 グループとしてグループごとに

補正を行います。 

 

Median Filtering をクリックします。Use median filtering にチェックを入れます。 

Y-axis、X-axis の設定がデフォルト表示されます。変更する際には、Settings をクリックし

ます。 
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Y軸ウインドウの Upper limitと Lower limitに値（RU）を入力します。X軸ウインドウのWindow 

width（サイクル数）を設定します。5 以上に設定します。OK をクリックします。 

（Y 軸ウインドウは、左のプロットの赤または青ラインをマウスポインターでドラッグして

設定することもできます。） 

 
左プロットの紫色のラインは各サイクルについて算出された中央値です。Y 軸の Upper limit

は赤ライン、Lower line は青ラインです。右プロットでは、中央値が Y = 0 に設定され、各ポ

イントから中央値が引かれた値がプロットされています。 

 

OK をクリックします。 
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設定した補正が全て適用されたプロットが表示されます。 

↓ 

Ranking/Cut-off タブをクリックします。 

Ranking または Cut-off の設定ができます。（Ranking と Cut-off は同時に設定できません。） 
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Ranking 

Mode→Ranking を選択します。 

 

コントロールサンプルを測定している場合には、ランキングの値としてコントロールサン

プルの平均値が自動設定されます。 

上のプロットでは、ネガティブコントロールとポジティブコントロールの平均値で、それ

ぞれ Low、Medium のラインが引かれています。 

Table の Ranking に、ランキング結果が表示されます。Low 以下のポイントは Lowest Points、

Medium 以下のポイントは Low、Medium より大きいポイントは Medium とランキングされま

す。Value には、ランキング用の数値が入力されています。 

 

ランキングのレスポンス、Name および Value を変更したい場合には、プロット上のライン

をマウスポインターでドラックして変更するか、下の一覧の該当する Name を選択後、Edit

をクリックして変更を行います。ランキング項目を増やしたい場合には、New をクリック

して追加します。 
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Cut-off 

Mode→Cut-off を選択します。 

デフォルトでは選択したサンプル（通常、ネガティブコントロール）の 3SD に Cut-off 値が

設定されています。画面下の Edit Settings で Cut-off 値の設定が可能です。数値で設定した

い場合には、画面下の Manual を選択後、Edit Settings でレスポンスを設定します。 

 

Table の Cut-off に結果が表示されます。Cut-off 以下の値は Below Cut-off、Cut-off 値より大き

い値では Above Cut-off と表示されます。 

↓ 

画面右下の Finish をクリックして、Result Plot の解析を終了します。 

画面左の Plot フォルダ内に、Result Plot が追加されます。再解析を行いたい場合には、Result 

Plot を選択後、マウス右クリック、Edit を選択します。File→Save as で結果を保存します。

解析結果は、File→Export→Result To Excel で、テキスト形式で保存できます。 

プロットは、プロット上でマウス右クリック、Copy Graph を選択後、Paint または WordPad

に貼り付けて保存します。 

 

解析メソッドの保存・実行 

同じ内容で繰り返し測定・解析を行う場合には、設定した解析方法をメソッドとして保存

して、次回の解析で使用することができます。メソッドを保存する場合には、File→Save 

Evaluation Method As を選択して保存先と保存内容を指定します。メソッド使用時には、
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解析データを File→Open で呼び出し後、File→Apply Evaluation Method を選択してメソッ

ドを呼び出し適用します。 

 

補足 1-8. 注釈・コメントの追加 

選択したポイントに対して注釈、コメントを Table に追加できます。 

例えば、プロット確認時に、溶液効果が大きいポイントや Rmax を超えているポイントに注

釈・コメントを入れることができます。 

 

 

画面右の Tools→Edit Annotations をクリックします。 

 
Add Annotation を選択して、注釈を入力します。また、Annotation を選択した状態で、Add 

Comment を選択して、コメントを追加します。コメントは複数追加できます。 

別途、Annotation を追加する場合には、上記操作を繰り返します。 
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作成した Annotation を保存して、別データの解析時に使用する場合には、下の Save 

Annotation As Template にチェックを入れます。保存しない場合には、作成した Annotation

は実行中のファイル内のみで適用されます。また、最終保存したものがテンプレートとな

ります。 

OK をクリックします。 

↓ 

Annotation を入れる場合には、プロットのポイントを選択して、Table の該当サンプル上で

マウス右クリック、Annotations を選択して、Annotation から Comment を選択します。Table

に情報が追加されます。 
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補足 1-9. Curve Fitting 

Result Plot の Curve fitting タブでは、プロットを Linear または 4-parameter で Fitting するこ

とができます。 

 

 

レポートポイントテーブルの確認 

画面右の Report Point Table を選択します。 

↓ 

Evaluation Explorer に Report Point Table フォルダとファイルが追加され、Work area には、全

測定サイクル分のデータが表示されます。 
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各カラム上部のフィルター を使用し、必要データを抽出できます。 

Fc   リファレンス差し引きデータ 

Report Point  binding（結合レスポンスのレポートポイント名） 

Assay Step  Sample（緩衝液添加サイクルなどを除きます） 

 

を 2 回クリックすると、結合レスポンスが高い順に並びます。 

補足 1-10. レポートポイントの追加 

Tools → Custom Report Points…をクリックします。 

 

 

 

 

 

 

 

 

 

Add…をクリックします。 

↓ 

 

 

 

 

 

 

 

 

Id にレポートポイントの名前を入力します。追加する位置を設定し、Cycles でどのサイクル

で記録するか設定します。OK をクリックします。 

↓ 
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初期画面に、追加したレポートポイントが表示されます。

補足 1-11. 結合量のグラフ化 

結合量を棒グラフとして表示する場合には、Toolbar の をクリックします。 

 

結合量が棒グラフとして表示されます。 

Curve でグラフ化するセンサーグラムを選択します。複数選択も可能です。 

表示方法、色、カラムラベルの表示を変更する場合には、Tools をクリックして変更したい

項目を選択します。 
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2. Kinetics/Affinity スクリーニング 
 

解析ソフトウェアの、Kinetics/Affinity scree を使用することで、多サンプルの Kinetics/Affinity

解析を一括して行うことができます。複数のデータファイルを持ち込んで一括解析を行う

ことも可能です。最大 200 濃度シリーズ（5 濃度, data correction rate; 10Hz）の解析が可能で

す。マルチサイクル法、シングルサイクル法で可能です。 

測定プログラムは、サンプル数が少ない場合と同様で、wizard の Kinetics/Affinity または、メ

ソッドを使用します。（日本語取扱説明書 基本操作編 5. 相互作用測定を参照ください。）

ここでは、Kinetics スクリーニング、Affinity スクリーニングについて、解析ソフトウェアの

使用方法を紹介します。 

 

2-1. Kinetics スクリーニングのデータ解析 

溶媒補正が必要な場合には、溶媒補正後に解析に進みます。（Biacore T200 日本語取扱説明

書 応用編 3 章を参照。）また、解析前に、Plot を使用したデータの QC を行ってください。

（（Biacore T200 日本語取扱説明書 応用編 1-2 章を参照。） 
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補足 2-1. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 

 

Tool bar の をクリックし、 をクリックします。 

↓ 

 

Name  解析結果の名前（必要に応じて変更します） 

Curve Type ReferenceSubtraction を選択します 

Temperature 温度を変えて測定している場合には、解析する温度を選択します 
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画面下の Table の Include で、解析に持ち込むサンプルにチェックを入れます。 

↓ 

 

画面左に、ゼロ濃度を差し引いたセンサーグラムの一覧が表示されます。表示は、View の、

Small Thumbnails、Standard Thumbnails、Extended Thumbnails で変更できます。並びは、

Arrange By で変更できます。選択したセンサーグラムの詳細情報は、画面右で確認できます。 

 

ブランクサブトラクション、サンプルサイクルの選択 
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センサーグラム下の Display Blanks を選択すると、そのサンプル名のゼロ濃度センサーグ

ラム（ブランク）が表示されます。画面下の Included Curves の を選択するとゼロ濃度

サイクルとサンプルサイクルの一覧を確認できます。ここで、ゼロ濃度および解析に持ち

込むサンプルの選択が可能です。Include のチェックを外すと、解析から除くことができま

す。ゼロ濃度サイクルが複数ある場合には、選択したゼロ濃度センサーグラムの平均が差

し引かれます。なお、ゼロ濃度の測定を行っていない場合には、Table 下の Blanks from other 

sample series から選択することができます。 

 

ステータスの設定 

各センサーグラムのステータスを設定できます。 

ここでは、次の 3 つのステータスを設定できます。 

 Rejected 解析に持ち込まないセンサーグラム 

  （結合していない、乱れが大きいなど） 

  Cleared デフォルト設定、解析に持ち込むセンサーグラム 

  Flagged 解析に持ち込むが、Flag を立てるセンサーグラム 

ステータスを設定する場合には、画面左の各センサーグラムの をクリックして、ステー

タスを変更します。または、センサーグラム上で右クリックして、ステータスを選択しま

す。 
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左上の Tools→Hide Rejected で、Reject したセンサーグラムを非表示にできます。 

Clear Flags で、Flag を解除できます。 

注釈・コメントを設定したい場合には、補足 2-2 を参照ください。 

 

補足 2-2. 注釈・コメントの追加 

選択したセンサーグラムに注釈・コメントを追加できます。 

例えば、センサーグラム確認時に、溶液効果が大きいポイントや Rmax を超えているポイン

トに注釈・コメントを入れることができます。 

 

画面左の Tools →Annotations をクリックします。 
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Add Annotation を選択して、注釈を入力します。また、Annotation を選択した状態で、Add 

Comment を選択して、コメントを追加します。コメントは複数追加できます。 

別途、Annotation を追加する場合には、上記操作を繰り返します。 

 

作成した Annotation を保存して、別データの解析時に使用する場合には、下の Save 

Annotation As Template にチェックを入れます。保存しない場合には、作成した Annotation

は実行中のファイル内のみで適用されます。また、最終保存したものがテンプレートとな

ります。 

OK をクリックします。 

↓ 

Annotation を入れる場合には、プロットのポイントを選択して、Table の該当サンプル上で
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マウス右クリック、Annotations を選択して、選択したい Annotation から Comment を選択

します。Results Summaryタブの TableのAnnotationで、設定したコメントを確認できます。 

 

↓ 

添加開始・終了時のノイズを除きたい場合には、画面左上の Tools の Remove Ranges をク

リックします。 
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画面下のスライダーを動かして、解析から除く範囲を設定します。 

OK をクリックすると、全てのセンサーグラムに設定した範囲が適用されます。 

 

それぞれのセンサーグラムで、センサーグラムの領域削除を行いたい場合には、Thumbnails

タブでセンサーグラムを選択後、右上の Tools→Select Data をクリックします。 
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センサーグラム上で、マウスの右クリック、ドラッグで範囲を設定し Remove Selection を

選択します。選択した領域が削除されます。OK をクリックします。 

↓ 

解析モデルの設定を行います。 

画面左上の Settings の Fit Settings をクリックします。 

↓ 

 

Model  解析モデルを選択します 

Parameters 選択したモデルの初期値、Fitting 方法などの変更ができます 

 

Apply To で、選択したモデルを適用するセンサーグラムを選択します。 

Selected  Thumbnails タブで選択したセンサーグラム 

Cleared  ステータスが Cleared の全センサーグラム 

Flagged  ステータスが Flagged の全センサーグラム 
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↓ 

モデルの設定が終了したら、Fitting を実行します。 

画面左上の Fit をクリックします。 

 
Fitting を行うセンサーグラムを指定して OK をクリックします。 

↓ 

 

Fitting が開始します。解析を行っているサンプルは、上の Table に が表示されます。 

Fitting の途中の解析を採用する場合は、右下の Accept Current をクリックします。Fitting

の途中で解析を終了させる場合には、Abort Current をクリックします。解析しているサン

プル以降の解析を中止する場合には、Abort Remaining をクリックします。 

↓ 

全サンプルの解析が終了すると、解析結果が表示されます。 
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既存の 1:1 Bindingモデルでは、解析結果のQuality Control結果が表示されます。詳細内容は、

Biacore T200 日本語取扱説明書 基本操作編 補足 5-10 をご参照ください。 

Thumbnails タブのセンサーグラムにも Quality Control の結果が表示されます。問題がある

場合には、 マークが入ります。該当センサーグラムを選択して、画面右で詳細を確認し

ます。 

 

解析結果のステータス 

Thumbnails タブで各センサーグラムの解析結果のステータスの設定を行います。 

ここでは、次の 4 つのステータスを設定できます。 

 Rejected 解析結果を採用しない 

  Cleared デフォルト設定 

  Flagged Flag を立てる 

  Accepted 結果を採用する 
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ステータスを設定する場合には、画面左のセンサーグラムの をクリックして、ステータ

スを変更します。または、センサーグラム上で右クリックして、ステータスを選択します。 

Thumbnails タブのセンサーグラムを選択後、画面右に表示されるセンサーグラム上の

Status でも変更できます。 

 

画面左上の Tools→Hide Rejected で、Reject したセンサーグラムを非表示にできます。 

Clear Flags で、Flag を解除できます。 

注釈・コメントを設定したい場合には、補足 2-2 をご参照ください。 

 

Results Summary タブを選択すると、On-Off Rate Map を確認できます。 

Table で解析結果、ステータス、注釈・コメントを確認できます。 

 

On-Off rate Map を保存したい場合には、Map 上でマウス右クリック、Copy Graph で Paint

または Word Pad に貼り付けて保存します。または、Export Curves で、テキスト形式で保

存できます。 

 

ウインドウ右下の Finish をクリックして、解析結果を最終化します。 

↓ 

画面左の Screening フォルダ内に結果が追加されます。再解析を行う場合には、
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上で右クリック、Edit をクリックします。 

Menubar の File→Save as で結果を保存します。 

解析後のセンサーグラムと Table 情報を Export したい場合には、Thumbnails タブ内で、マウ

ス右クリック、Export All Graphs And Table を選択して、保存先を指定します。フォルダが

作成され、Thumbnails タブで表示されている全てのセンサーグラム（拡張子：png）と Table

情報（拡張子：txt）が Export されます。 

引き続き、Affinity スクリーニングのデータ解析を行う場合には、2-2 に進みます。 

 

2-2. Affinity スクリーニングのデータ解析 

Tool bar の をクリックし、 をクリックします。 

↓ 

 

Name  解析結果の名前（必要に応じて変更します） 

Curve Type サイクルタイプを選択します 

Temperature 温度を変えて測定している場合には、解析する温度を選択します 

画面下の Table の Include で、解析に持ち込むサンプルにチェックを入れます。 

↓ 
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画面左に、ゼロ濃度を差し引いたセンサーグラムの一覧が表示されます。表示は、View の、

Small Thumbnails、Standard Thumbnails、Extended Thumbnails で変更できます。並びは、

Arrange By で変更できます。選択したセンサーグラムの詳細情報は画面右で確認できます。 

 

ブランクサブトラクション、サンプルサイクルの選択 

 

センサーグラム下の Display Blanks を選択すると、そのサンプル名のゼロ濃度センサーグ

ラム（ブランク）が表示されます。画面下の Included Curves の を選択するとゼロ濃度サ
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イクルとサンプルサイクルの一覧を確認できます。ここで、ゼロ濃度および解析に持ち込

むサンプルの選択が可能です。Includeのチェックを外すと、解析から除くことができます。

ゼロ濃度サイクルが複数ある場合には、選択したゼロ濃度センサーグラムの平均が差し引

かれます。なお、ゼロ濃度の測定を行っていない場合には、Table 下の Blanks from other 

sample series から選択することができます。 

 

ステータスの設定 

各センサーグラムのステータスを設定できます。 

ここでは、次の 3 つのステータスを設定できます。 

 Rejected 解析に持ち込まないセンサーグラム 

  （結合していない、乱れが大きいなど） 

  Cleared デフォルト設定、解析に持ち込むセンサーグラム 

  Flagged 解析に持ち込むが、Flag を立てるセンサーグラム 

ステータスを設定する場合には、画面左の各センサーグラムの をクリックして、ステー

タスを変更します。または、センサーグラム上で右クリックして、ステータスを選択しま

す。 

 

画面左上の Tools→Hide Rejected で、Reject したセンサーグラムを非表示にできます。 

Clear Flags で、Flag を解除できます。 

注釈・コメントを設定したい場合には、補足 2-2 を参照ください。 

↓ 

添加開始・終了時のノイズを除きたい場合には、画面左上の Tools→Remove Ranges をク

リックします。 
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画面下のスライダーを動かして、解析から除く範囲を設定します。 

OK をクリックすると、全てのセンサーグラムに設定した範囲が適用されます。 

 

それぞれのセンサーグラムで、センサーグラムの領域削除を行いたい場合には、Thumbnails

タブでセンサーグラムを選択後、右上の Tools→Select Data をクリックします。 

 

センサーグラム上で、マウスの右クリック、ドラッグで範囲設定し Remove Selection を選

択します。選択した領域が削除されます。OK をクリックします。 

↓ 

Affinity 解析で用いる、レポートポイントの設定を行います。 

画面左上の Settings の Report Point Settings をクリックします。 

 

デフォルトでは、添加終了 4 秒前に設定されています。必要に応じて変更を行います。 

Apply To で適用するセンサーグラムを選択します。OK をクリックします。 

↓ 
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解析モデルの設定を行います。 

画面左上の Settings→Fit Settings をクリックします。 

 

Model  解析モデルを選択します 

  （モデルについては補足 2-3 を参照） 

Parameters 選択したモデルの初期値、Fitting 方法などの変更ができます 

 

Apply To で、選択したモデルを適用するセンサーグラムを選択します。 

Selected  Thumbnails タブで選択したセンサーグラム 

Cleared  ステータスが Cleared の全センサーグラム 

Flagged  ステータスが Flagged の全センサーグラム 

 

 

補足 2-3. Affinity スクリーニングの解析モデル 

次の 3 つのモデルから選択できます。 

 

Steady State Affinity 

1:1 Binding モデルの Affinity 解析モデル。 

 

Steady State Affinity Constant Rmax 

1:1 Binding モデルで、Rmaxを設定値で解析するモデル。 

低アフィニティーでアナライト濃度を高濃度に設定できない場合に使用します。 
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設定する Rmax値は、ポジティブコントロールを Rmaxに到達する高濃度で添加して得られる

結合量か、ポジティブコントロールの解析結果で得られた値を Rmaxとして使用します。

Control Rmax の欄に入力する値の単位は、RU/ 100 Da です。 

例えば、ポジティブコントロールの結合量が 30 RU で分子量が 300 Da の場合には、Control 

Rmax の値は、結合量 × 100 / ポジティブコントロール分子量 = 30 RU × 100 / 300 Da = 30（RU 

/ 100 Da）となります。 

解析時には、アナライトの分子量差を次の式で補正した値を、各アナライトの Rmax値とし

て適用します。 

 
さらに、リガンドの活性低下を考慮した補正を行いたい場合は、Adjust Rmax For Controls

をクリックして、補正に使用するポジティブコントロールを設定します。この際、設定す

るポジティブコントロールの Rmax値（Control Rmax に入力する値）は、サイクルはじめの

ポジティブコントロールの結合量（RU / 100 Da）を入力してください。 
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Rmaxの補正には、全サイクルのポジティブコントロールの結合量をLinearまたはPolynomial

で Fitting して得られる補正曲線を使用します。各サンプルの濃度シリーズのはじめのサイ

クルに対応する補正曲線の Y 軸の値を Control Rmax 値として使用します。濃度シリーズ内

ではその値を固定値とします。 

 

 

Steady State Affinity Constant Rmax (Multi Site) 

リガンド上に結合サイトが 2 つあることを想定したモデル。 

高濃度で弱い親和性の結合が確認できる場合などに使用します。 

 

Steady State Affinity Constant Rmax と同様に、Control Rmax の値（Rmaxの値）を設定します。

（Rmax2は変数として解析を行います。）必要に応じて、Adjust Rmax For Controls を使用し

ます。 
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↓ 

モデルの設定が終了したら、Fitting を実行します。 

画面左上の Fit をクリックします。 

 
Fitting を行うセンサーグラムを指定して OK をクリックします。 

↓ 

 

Fitting が開始します。解析を行っているサンプルは、上の Table に が表示されます。 

解析していないサンプルの解析を中断する場合には、Abort Remaining をクリックします。 

↓ 

全サンプルの解析が終了すると、解析結果が表示されます。 
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Thumbnails タブで選択したプロットの結果を、画面右で確認できます。 

 

解析結果のステータス 

Thumbnails タブで各センサーグラムの解析結果のステータスを設定できます。 

ここでは、次の 4 つのステータスを設定できます。 

 Rejected 解析結果を採用しない 

  Cleared デフォルト設定 

  Flagged Flag を立てる 

  Accepted 結果を採用する 

ステータスを設定する場合には、画面左のプロットの をクリックして、ステータスを変

更します。または、プロット上で右クリックして、ステータスを選択します。 

Thumbnails タブのプロットを選択後、画面右に表示されるセンサーグラム上の Status でも

変更できます。 
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画面左上の Tools→Hide Rejected で、Reject したセンサーグラムを非表示にできます。 

Clear Flags で、Flag を解除できます。 

注釈・コメントを設定したい場合には、補足 2-2 を参照ください。 

 

Results Summary タブを選択すると、KD Plot を確認できます。 

Table で解析結果、ステータス、注釈・コメントを確認できます。 

 

KD Plot を保存する場合は、Plot 上でマウス右クリック、Copy Graphで Paint または Word Pad

に貼り付けて保存します。または、Export Curves で、テキスト形式で保存できます。 

 

ウインドウ右下の Finish をクリックして、解析結果を最終化します。 

↓ 

画面左の Screening フォルダ内に結果が追加されます。再解析を行う場合には、

上で右クリック、Edit をクリックします。 

Menubar の File→Save as で結果を保存します。 

解析後のセンサーグラムと Table 情報を Export したい場合には、Thumbnails タブ内で、マ

ウス右クリック、Export All Graphs And Table を選択して、保存先を指定します。フォルダ

が作成され、Thumbnails タブで表示されている全てのセンサーグラム（拡張子：png）と

Table 情報（拡張子：txt）が Export されます。 
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解析メソッドの保存・実行 

同じ内容で繰り返し測定・解析を行う場合には、設定した解析方法をメソッドとして保存

して、次回の解析で使用することができます。 

メソッドを保存する場合には、Menubar の File→Save Evaluation Method As を選択して保

存先と保存内容を指定します。 

メソッド使用時には、解析データを File→Open で呼び出し後、File→Apply Evaluation 

Method を選択してメソッドを呼び出します。
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3. 低分子化合物アナライトの相互作用測定 
 

低分子化合物の溶解性の問題で有機溶媒を利用する場合には、一般的なタンパク質-タンパ

ク質相互作用測定と異なり、ランニング緩衝液およびサンプル調製に注意が必要です。ま

た、測定結果を評価するにあたり溶媒効果の補正が必要となります。 

複数サンプルのスクリーニング、Kinetics/Affinity スクリーニングを実施する場合には、

Biacore T200 日本語取扱説明書 応用編の 1、2 章をあらかじめ参照ください。 

 

アナライトの調製 

アナライト溶液の DMSO の終濃度をランニング緩衝液と合わせます。化合物濃度は結合ス

クリーニングが目的の場合、親和性にもよりますが数十 nM～数 μM で調製します。反応速

度定数の算出が目的の場合、KD（解離定数）値の 1/10～10 倍の濃度範囲で 5 濃度以上調製

します。 

 

ランニング緩衝液 

PBS や HEPES 緩衝液が広く使用されます。HEPES は、ヒト血清アルブミンや各種タンパク

質への結合が見られます。この場合には、PBS などを使用してください。有機溶媒を使用す

る場合には、DMSO 含有緩衝液を使用することが多いです。DMSO 濃度は 5%程度以下を推

奨します。DMSO 濃度はリガンドの活性や化合物の溶解性を考慮し決定します。ランニング

緩衝液に使用できる DMSO 濃度は 10%までとなります。非特異的吸着を抑える目的で、終

濃度 0.05%程度の界面活性剤（Surfactant P20 など）を添加することもあります。 

 

補足 3-1. ランニング緩衝液調製の注意事項 

・ランニング緩衝液は用事調製してください。 

・DMSO を扱う際は、耐性がある材質の容器を使用します。（プラスチック容器は使用不可） 

・DMSO を含む緩衝液をろ過する際には、フッ素樹脂製またはナイロン製のフィルター（0.22 

μm）を用います。酢酸セルロース製のものは避けてください。 

・DMSO 溶液中の混合物も測定に影響をおよぼす場合があるのでグレードの高いもの（UV 

spectrometry 用など）を使用してください。また、フレッシュなものを使用してください。 

・DMSO 混合による pH 変動は大きいため、DMSO 混合後の pH を考慮してください。 

・きれいなガラスボトルに保存し、装置にセットする直前までキャップはしっかり閉めて

ください。 

・装置のボトルポジションにセットする際は必ず付属のスクリューキャップを使用してく

ださい。
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溶媒補正 

SPR のシグナルはセンサーチップ表面での様々な屈折率（RI）の変化を反映しています。セ

ンサーチップ表面での結合反応だけでなく、ランニング緩衝液とサンプルを溶解している

溶媒の屈折率の差、すなわち、溶媒（バルク）効果レスポンスが含まれます。 

溶媒効果が小さい（100 RU 以下）実験では、リガンド固定化セルからリファレンスセルの

レスポンスを差し引くだけでこのバルクレスポンスは排除できます。 

しかし、厳密には、リガンド固定化セルに添加した溶液は、リガンド分子の占有体積分排

除されるため、リファレンスセルのバルクレスポンスは、リガンド固定化セルよりも高く

なります。 

 
ランニング緩衝液とアナライト溶液中のDMSO濃度 1%の違いは約 1,500 RUのバルクレスポ

ンスに相当します。複数あるサンプルを個々に調製する際、DMSO 濃度の誤差が無視できな

いバルクレスポンスの差を生む可能性があります。 

このように、溶媒効果が大きい DMSO を用いる実験では、単純に差し引くだけではバルク

レスポンスの差を十分に排除することはできません。実際、このバルクレスポンスの差は

小さくても（通常 10 RU以下）、低分子化合物が結合した際に得られる結合レスポンスと同

程度であるため、バルクの差を補正する必要があります。 

 

溶媒補正は以下の 3 つの要因が重複した際必要となります。 

・ 期待されるアナライトの結合レスポンスが小さい（100 RU 以下）場合 

・ リガンドを高密度（10,000 RU 以上）に固定化した場合 

・ サンプル溶液に DMSO が含まれるなど、バルクレスポンスが大きく（3000 RU 以上）、

サンプル間で値が異なる場合（DMSO 濃度の“誤差”も含めて） 

 

 

リファレンスセル   リガンド固定化セル 

DMSOのバルクレスポンス差 
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補足 3-2. 溶媒補正の方法 

溶媒補正の手順 

Biacore T200 Evaluation Software では、自動で以下の補正を実施します。 

・ 測定の際に、DMSO 溶液の濃度シリーズ（ランニング緩衝液に含まれる DMSO 濃度±1 %

程度）を、リガンド固定化セルおよびリファレンスセルに添加し、固定化セルとリァ

レンスセルのバルクレスポンスの差を記録します。 

・ リファレンスセルのレスポンスを x 軸、固定化セルとリファレンスセルのバルクレスポ

ンスの差を y 軸にプロットして溶媒補正用曲線を作成します。 

・ 低分子化合物を添加した際、リファレンスセルのレスポンス（図①）を溶媒補正用曲

線に代入して、補正値を算出します（図②）。 

・ 相互作用測定で得られた結合レスポンスから補正値を差し引きます（図③）。 

①         ②          ③ 

 

 

 

 

 

溶媒補正用 DMSO 溶液の調製例 

5 % DMSO 含有サンプルを用いる場合の溶媒補正用 DMSO 溶液の作成方法を記載します。 

すべての DMSO 溶液は用事調製します。 

①1x PBS（no DMSO）を調製します。 

②溶媒補正用曲線 4 %、6% DMSO ストック溶液を調製します。 

 4% DMSO ストック溶液  1x ランニング緩衝液 9600 μl 

     100 % DMSO   400 μl 

        10000 μl 

 

 6% DMSO ストック溶液  1x ランニング緩衝液 9400 μl 

     100 % DMSO   600 μl 

           10000 μl 

③ストック溶液を下記表の割合で混合して、4 %～6 %の溶媒補正用 DMSO 溶液を調製しま

す。以下の表は 8 段階の溶媒補正用 DMSO 溶液を調製する際のプロトコールです。 

4% DMSO   100  200 300 400 500 600 700 

6% DMSO 700  600  500 400 300 200 100          

700  700  700 700 700 700 700 700  （μl） 



 
 

3. 低分子化合物アナライトの相互作用測定   57 

 

Biacore T200 

日本語取扱説明書 

3-1. プログラムの実行 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run→Wizard をクリックします。 

 

Assay→Kinetics/Affinity を選択した後、New…をクリックします。（4 つのセルを使用する場

合や、Binding Analysis を行う場合にはテンプレートのメソッドを使用します。） 

以前にプログラムを Methods and Templates フォルダに保存している場合は、右側の一覧表

に反映されます。同じプログラムを実行したい場合は、Open をクリックします。別のフォ

ルダに保存されているプログラムを実行したい場合は、Browse をクリックし、目的のプロ

グラムをハイライトにして Open をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 サイクル分の測定シークエンスを設定します。
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Detection 

Flow path  2-1 もしくは 4-3 を選択します 

Chip    

 Chip type  利用するセンサーチップを選択します 

Capture 

アナライトの添加前に、固定化したキャプチャー分子に対して、リガンドを捕捉

する場合にチェックを入れます。リガンドは、フローセル 2 もしくはフローセル 4

にキャプチャーされます。 

Sample 

アナライトの添加コマンドです 

Regeneration 

再生が必要な場合にチェックを入れます。添加回数の選択が可能です（1 or 2） 

Carry Over 

 アナライトのキャリーオーバーを確認する場合にチェックを入れます 

 

Next >をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

Conditioning 

Solution  再生溶液または緩衝液の名称 

contact time 添加時間（s）

Number of injections 添加回数 

Startup 

Solution  指定した溶液で、相互作用測定と同様の工程をアナラ

イト測定前に実施します。通常は、ランニング緩衝液を
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用います。 

Number of cycles サイクル数を設定します。3 回以上を推奨します。 

Solvent correction   

溶媒補正を実施する場合にチェックを入れます。 

    Number of injections 溶媒補正の測定点を選択します。何サンプルごとに溶媒

補正を実施するかを、 ”Repeat after     Sample 

cycles”で指定します。 

Next >をクリックします。 

↓  

 

Sample 

contact time  アナライトの添加時間 120 s 

Flow rate   流速   30 μl/min 

Dissociation time  解離時間  120 s 

 Extra wash after injection with 

アナライト添加後に、指定した溶液でフローセル以外

の流路を洗浄したい場合にチェックを入れます。セン

サーチップ表面には流れません。 

Stabilization period 添加後のベースライン安定化時間 0 s 

   （必要に応じて設定します。） 

 

入力後、Next をクリックします。 

↓ 
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Sample id  アナライトの名称 

MW （Da）  アナライトの分子量 

Concentration  アナライトの濃度（単位も選択） 

分子量と濃度を入力すると、自動的に“モル濃度 nM ”と

“重量濃度 μg/ml”を換算します。 

 

コントロールサンプルを定期的に添加する場合は、Control Samples をクリックします。 
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Control Sample definition 

コントロールサンプルを測定する場合に Run control Samples にチェックを入れます。 

Repeat control Sample（s） every 何サンプルごとにコントロールサンプルを測定 

        するか指定します。 

Control Samples 

 テーブルにコントロールサンプルの情報を入力します。 

 

入力後、Next をクリックします。 

 

補足 3-3. Excel ファイルで作成したサンプル情報の入力 

Excel ファイルで作成したサンプル情報を移行するには、Excel での保存時、タブ区切りのテ

キストファイル（拡張子は txt）を選択します。タブ区切りで保存したデータを上記画面で

開き、コピーペーストで入力します。 

↓ 

 

 

 

 

 

 

 

測定を始める前の Prime および Normalize の実施を選択します。 

Temperature settings 

Analysis temperature   25℃ 

Sample compartment temperature  25℃ 

 

Cycle Run List をクリックすると、測定サイクルのリストが表示されます。 
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Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

右側の表でサンプルの位置と容量（μl）を確認します。表中のサンプルをクリックするとそ

れに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイアルお

よびサンプルをラックにセットします。 

 

補足 3-4. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 
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補足 3-5. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分別して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することが出来ます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。 
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Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。 

Eject Rack Tray ダイアログが閉じた後、Rack Positions ダイアログ右下の Next をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 
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Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動保存され、Biacore T200 Evaluation Software が自動

的に起動します。

 

 

補足 3-6. プログラムの緊急停止 

Run → Stop Run…をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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補足 3-7. レポートポイントの設定 

溶媒（バルク）補正を必要とする実験では、低分子アナライトのバルクレスポンスを測定

するために、アナライト添加中（添加終了直前）にレポートポイントを取得する必要があ

ります。自動取得されるレポートポイントの名前は binding と付いています。添加終了直後

のレポートポイントは stability として取得されます。また、低分子アナライト特有のニード

ル、流路等へのキャリーオーバーチェックのために、アナライト添加終了後、ランニング

緩衝液をアナライトと同等のモードで添加する際に取得されるレポートポイントの名前は、

頭に co-が付いています。 

 

 

 

補足 3-8. キャプチャー法を利用した低分子化合物の測定 

Wizard の Binding analysis および Kinetics / Affinity では、溶媒補正曲線の測定を、リガンドを

キャプチャーせずに実施します。リガンドキャプチャー後のベースラインドリフトが小さ

く、一度リガンドをキャプチャーした表面で連続してアナライトの測定を実施する場合に

は、Wizard のキャプチャー機能を利用した測定が実施できます。 

ただし、キャプチャー後のベースラインドリフトが大きく、アナライトごとにリガンドを

キャプチャーする場合は、溶媒補正曲線の測定はリガンドキャプチャー後の表面で実施し

てください。この際、測定プログラムはメソッドで作成する必要があります。メソッド作

成については、Biacore T200 日本語取扱説明書 基本操作編 6 章を参照してください。

binding 

stability 
co_binding 

co_stability 

Sample 

Regeneration 

Carry-over control 
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3-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

スクリーニング、反応速度定数・解離定数算出は、溶媒補正実施後に解析に進みます。解

析方法は、Biacore T200 日本語取扱説明書 基本操作編 を参照してください。複数サンプル

のスクリーニング、Kinetics/Affinity スクリーニングを実施する場合には、Biacore T200 日本

語取扱説明書 応用編の 1、2 章を参照ください。 

ここでは、溶媒補正方法までをご紹介します。 

 

溶媒補正 

Evaluation → Add Solvent correction…をクリックします。 

測定サイクル中の溶媒補正用曲線が表示されます。 

 

画面左で使用する補正曲線にチェックを入れ、OK をクリックすると補正が完了します。 

溶媒補正用曲線は、Evaluation Explorer中 Solvent Correctionフォルダに追加保存されます。 

センサーグラムおよびプロットで、補正後のデータを呼び出す際には、Curve Name リスト

から、末端に corr が付いたものを選択します。例：Fc2-1 corr。 

リファレンス

セルで発生し

ている全測定

サンプルのバ

ルク幅 
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補足 3-9. 測定ポイントの削除 

エアーの混入などの理由で、溶媒補正用曲線から削除したい測定ポイントがある場合は、

その測定ポイント上にカーソルを移動し、マウスを右クリックします。 

 

Exclude point をクリックします。 

↓ 

 

測定ポイントが削除されます。同時に、改めて残りの測定ポイントで溶媒補正用曲線が作

成されます。 
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補足 3-10. 溶媒補正用曲線の削除 

エアーの添加などの理由で解析から削除したい溶媒補正用曲線がある場合、目的の溶媒補

正用曲線について、Solvent correction 左の Table の Include カラムのチェックを外します。 

 

↓ 

 

チェックを外した溶媒補正用曲線が削除されます。 
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補足 3-11. 溶媒補正用曲線の延長 

サンプルもしくは溶媒補正用 DMSO 溶液の調製の問題で、測定サンプルのバルクレスポン

スが溶媒補正用 DMSO 溶液の範囲内に収まらなかった場合に、溶媒補正用 DMSO 溶液の濃

度幅（＝リファレンスセルに対するバルク幅）を広げることができます。ただし、延長さ

れた溶媒補正用曲線の領域での補正は、実測値とは異なるため補正値の取扱いには注意が

必要です。 

Solvent correction 左下の Extrapolate をクリックします。 

↓ 

 

延長する幅を入力します。実際の溶媒補正用曲線の測定幅の 10 %を超えないことが望まし

いです。OK をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

データの評価 

溶媒補正を実施後に解析に進みます。 

複数サンプルのスクリーニングの評価は、Biacore T200 日本語取扱説明書 応用編の 1 章を

参照ください。Kinetics/Affinity スクリーニングを実施する場合には、2 章を参照ください。 
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補足 3-12. 測定結果の正当性の評価 

Evaluation Explorer の Plot を用いて、得られたデータの信頼性があるかを評価します。 

 

ベースラインの変動 

Baseline: Sample プロット 

全測定サイクルの baseline の絶対値に対するプ

ロットが表示されます。物理吸着しているリガ

ンドがサイクルごとに脱離している場合、右肩

下がりになりますが、ポジティブコントロール

サンプルのレスポンスが確認できていれば問題

ありません。ポジティブコントロールがない場

合、全サイクルの総変動量（RU）が固定化量の

10%以上である場合には、その点を考慮して評価する必要があります。 

 

キャリーオーバーチェック 

Carry Over プロット 

co_binding の co_baseline に対する相対値プロッ

トが表示されます。ランニング緩衝液のレスポン

ス（画面では Startup サイクル）に対して、レス

ポンスの大きいアナライトはニードルや流路な

どに吸着する性質を持ちます。キャリーオーバー

が激しいアナライトの次サイクルの結合レスポ

ンスは、それを考慮して評価する必要があります。 

 

リファレンスセルへの非特異吸着の確認 

Binding to reference プロット 

Stability の baseline に対する相対値のプロットが

表示されます。ランニング緩衝液のレスポンスを

基準として評価します。ランニング緩衝液のレス

ポンス以上のサンプルは、センサーチップ表面へ

非特異的に吸着している可能性があります。それ

を考慮した上で評価してください。 
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4. 濃度測定 

4-1. 検量線を利用した濃度測定 

Biacore による濃度測定では、定量したい分子

（A）に対して親和性を持つ分子（B）が必要

となります。B を固定化したセンサーチップ

表面に A を添加すると、添加した濃度に依存

した結合レスポンス（RU）が得られます。数

段階の濃度既知の A を添加し、その結合レス

ポンスを得て、検量線（RU vs C）を作成しま

す。濃度未知の A に対しても同様に添加し、その結合レスポンスを検量線にフィッティン

グすることにより濃度を算出します。 

また、A 添加直後のセンサーグラムの傾き (Slope) も、結合レスポンス同様に添加している

A の濃度を反映した値となるため、Slope vs C の検量線からでも定量をすることができます。 

 

直接法と阻害法 

親和性を持つ分子（B）をセンサーチップ表面に固定化し、 

定量分子 A を添加して得られる結合レスポンスから直接 A 

の濃度を算出する方法を直接法と呼びます。それに対し、 

化合物やペプチドなど分子量が小さい分子を定量する場合 

は A もしくは A のアナログ（A’）をセンサーチップに固定 

し、定量分子 A と A に対して親和性を持つ分子 B を一定量 

混合した混合液を添加し、未反応の B を定量することによ 

り、混合液中に存在する A を逆算する定量法を阻害法と 

呼びます。 

 

阻害法 

 

 

 

 

 

 

 

 

+ 

 
   

結合レスポンス 

傾き 

阻害法の検量線  

A もしくは A’ 

B 

添加 

直接法の検量線 
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4-1-1. プログラムの実行 

濃度測定では、原則としてリファレンスセルを設定しません。評価に用いる結合量として、

溶液効果の影響を受けない解離領域における結合量を利用するためです。なお、非特異的

吸着を差し引く目的で、リファレンスセルを設定する場合には、あらかじめウィザードの

Concentration Analysis のテンプレートで作成したメソッドをメソッドビルダーで開き、リフ

ァレンスセルを設定して測定を実施してください。 

 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run → Wizard をクリックしま

す。 

 

 

 

 

Assay → Concentration Analysis を選択した後、New をクリックします。以前にプログラ

ムを Methods and Templates フォルダに保存している場合は、右側の一覧表に反映されます。

同じプログラムを実行したい場合は、Open をクリックします。別のフォルダに保存されて

いるプログラムを実行したい場合は、Browse をクリックし、目的のプログラムをハイライ

トにして Open をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 サイクル分の測定シークエンスを設定します。
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Detection 

    Flow path 目的のフローセルを選択します。リファレンスセルの差し引き

はできません。 

Chip 

 Chip type  利用するセンサーチップを選択します。 

 

Capture 

アナライトの添加前に、固定化したキャプチャー分子に対して、リガンドを捕捉

する場合にチェックを入れます。 

Sample 

アナライトの添加コマンドです 

Enhancement 

2 次抗体などを添加する場合にチェックを入れます 

Regeneration 

再生が必要な場合にチェックを入れます。添加回数を選択してください。（1 or 2） 

 

Next >をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

Startup 

指定した溶液（通常、ランニング緩衝液）で、サンプル測定と同様の工程をサン

プル（アナライト）測定前に実施します。

Solution  溶液名 

Number of cycles サイクル数。3 回以上を推奨します。 

 

Next >をクリックします。 

↓ 
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Sample 

contact time  アナライトの添加時間（s）  

Flow rate   流速（μl/min）    

Mix with  チェックを入れると、測定直前にサンプルと混合溶液

を自動混合します（阻害法による定量の場合に使用しま

す）。Fraction に混合後の溶液に対する、混合溶液の割

合（%）を入力します。 

（例）75%と入力した場合：サンプル 25%、混合溶液

75% 

 

Regeneration 

Solution   再生溶液の名称 

High viscosity solution 粘性の高い溶液（40% エチレングリコール以上）の場

合はチェックを入れます。 

contact time  再生溶液の添加時間（s） 

Flow rate   流速（μl/min） 

Stabilization period 添加終了後のベースライン安定化時間（s） 

 

Next >をクリックします。 

↓ 

 

 

 

 

 

 

 



 
 

76  4. 濃度測定 

Biacore T200 

日本語取扱説明書 

 

Calibration Curve  

Analyte name  アナライト（既知濃度サンプル）の名称 

Run first  検量線測定を測定の初めに実施するよう予め設定され

ています。 

Repeat calibration every 検量線作成頻度。 

指定したサンプル数ごとに検量線を実施します。チェッ

クを入れない場合には、サンプル測定前に 1 度検量線

を測定します。 

Run last   検量線測定を測定の最後に実施するかを設定します。 

 

Calibration points  

Concentration  単位をプルダウンで選択して、濃度を入力します。 

6 段階濃度以上、測定回数 2 回以上の繰り返し測定を推

奨します。 

テーブルに入力した順番で測定は実行します。 

 

Next をクリックします。 

↓ 
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Control Sample definition  

Run control Samples 

コントロールサンプルを測定する際にチェックします 

Repeat control Sample（s） every  

測定頻度を入力します 

コントロールは 20 サンプル程度ごとに入れます 

Control Samples 

Control Sample id  コントロールサンプルの名称 

Expected conc.  コントロールサンプルの濃度 

Next をクリックします。 

↓ 
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Sample id  サンプルの名称 

Dilution factor    サンプルの希釈倍率 

テーブルに入力した順番で測定します。 

Next をクリックします。 

↓ 

 

補足 4-1. Excel ファイルで作成したサンプル情報の入力 

Excel ファイルで作成したサンプル情報を移行するには、Excel での保存時、タブ区切りのテ

キストファイル（拡張子は txt）を選択します。タブ区切りで保存したデータを上記画面で

開き、コピーペーストで入力します。 

 

 

 

 

 

 

 

 

 

測定を始める前の Prime および Normalize の実施を選択します。 

Analysis temperature   25 ℃ 

Sample compartment temperature  25 ℃ 

 

Cycle Run List をクリックすると、測定サイクルを確認できます。 

 

 

 

 

 

 

 

 

 

Next をクリックします。 

↓ 
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右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 

 

補足 4-2. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 
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補足 4-3. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分注して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。
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Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。 

Eject Rack Tray ダイアログが閉じた後、Rack Positions ダイアログ右下の Next をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液の量が表示されます。 

Start をクリックします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

↓ 

終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動保存され、Biacore T200 Evaluation Software が自動

的に起動して、各サイクルの測定結果が重ね書き表示されます。
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補足 4-4. プログラムの緊急停止 

Run→Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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4-1-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

自動保存された取得データが開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

補足 4-5. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 4-6. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

Sensorgram window 
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Toolbar の           をクリックします。 

 

 

 

Using calibration をクリックします。 

↓ 

 

Concentration Analysis［Create］ボックスの Calibration が表示されます。 

 

Calibration Curve Settings 

Flow cell   解析に使用するセルの選択 

Report point  レポートポイントの選択 

Response type 結合レスポンス（Relative Response）で濃度測定するか、

傾き（Slope）で濃度測定するか選択します。 

Fitting Function 検量線を linear で引くか、4-parameter で引くか選択し

ます。 

Use preceding calibration curve 

 サンプル測定の直前で測定した検量線を利用する場合

にチェックを入れます。 

Use average calibration Curve 

 検量線を複数作成していて平均した検量線を利用する
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場合にチェックを入れます。 

Use calibration trends 検量線を複数作成している場合で、時間経過に伴う結合

量の低下を考慮したサイクル毎の検量線を利用する場

合にチェックを入れます。（サイクル毎の検量線はバー

チャル作成されます。）

設定した条件の検量線を確認します。 

Calibration Curve の もしくは をクリックし、目的のサイ

クルを選択します。複数の検量線を同時に確認する場合は、 を使用します。 

 

キーボードの Ctrl キーを押しながら、カラム中の目的の番号をクリックします。連続した

番号を選択する場合は、マウスをドラッグして選択可能です。 

 

 

 

画面右に設定した検量線が表示されます。Use calibration trends を選択した場合には、全

検量線の重ね書きが表示されます。 

画面左の Calibration Table に検量線の各測定ポイントの詳細情報が表示されます。Conc.に

はメソッドで入力した濃度、Calc.Conc.には作成した検量線から計算した濃度が表示されま

す。同一濃度で繰り返し測定している場合には、算出された濃度の CV 値が CV（%）に表示

されます。 

検量線の測定ポイントの選択削除、検量線の選択削除は、補足 4-7 および 4-8 を参照してく

ださい。 
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未知サンプルの測定結果 

Concentration Analysis［Create］ボックス上部の Samples のタブの付いたページをクリック

します。 

 

画面左の Sample Table にサンプル情報が表示されます。Dil.Fact.（希釈倍率）を掛けた濃度

が Calc.Conc.に表示されます。同一サンプルで繰り返し測定している場合には、算出された

濃度の CV 値が CV（%）に表示されます。 

クリックして選択したサンプルについては、画面右で強調表示されます。 

測定ポイントの選択削除は、補足 4-7 を参照してください。 

 

Finish をクリックします。 

↓ 

解析結果が、Evaluation Explorer 中のフォルダに保存されます。 
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補足 4-7. 測定ポイントの削除 

エアーの混入などの理由で、測定結果から削除したい測定ポイントがある場合は、その測

定ポイント上にカーソルを移動し、マウスを右クリックします。 

 

 
Exclude Cycle をクリックします。 

↓ 

測定ポイントが削除され、同時に Calibration Table の削除した測定ポイントに赤色の削除ラ

インが引かれます。 

 

検量線の測定ポイントを削除した場合には、改めて残りの測定ポイントで検量線が作り直

されます。 

再度採用する場合には、マウスを右クリックして、Include Cycle を選択します。 
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補足 4-8. 検量線の削除 

エアーの添加などの理由で、複数回数取得している検量線のうち、解析から削除したい検

量線がある場合、いずれかの測定ポイント上でマウスを右クリックします。 

 

 
Exclude Curve をクリックします。 

↓ 

検量線は削除され、同時に Calibration Table のその検量線を構成している全測定ポイントに

赤色の削除ラインが引かれます。 

 

 

再度採用する場合には、マウスを右クリックして、Include Curve を選択します。 
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補足 4-9. コントロールサンプルのレスポンスのチェック 

定期的にコントロールサンプルを添加している場合、その結合レスポンスを Concentration 

Analysis ［Create］ボックス上部の Control Samples のタブの付いたページでチェックするこ

とができます。 

 

 

 

補足 4-10. レポートポイントの追加 

Tools→Custom Report Points をクリックします。 
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Add をクリックします。

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Id にレポートポイントの名前を入力します。追加する位置を設定し、Cycles でどのサイクル

で記録するのか設定します。 

OK をクリックします。 

↓ 

 

 

 

 

 

初期画面に、追加したレポートポイントが表示されます。 

なお、追加したレポートポイントは、Calibration Settings の Report Point に追加されます。 
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4-2. 検量線不要の濃度測定 

 

CFCA （Calibration Free Concentration Analysis） 

検量線を必要としない濃度測定法（CFCA ; Calibration Free Concentration Analysis） は、アナ

ライトの拡散特性とセンサーグラムの結合領域初期における結合速度（初期結合速度）を

利用して、カーブフィッティングにより、結合活性を有するアナライト分子の絶対濃度を

算出する方法です。適した標準分子がない場合や、標準サンプルの結合活性濃度を確認し

たい場合に有効です。さらに、厳密な速度定数と親和定数を求める目的においても、CFCA

により絶対的な結合活性濃度を求めることは有効です。 

 

 

 

 

 

 

 

 

CFCA では、リガンドをできるだけ多く固定化（例：分子量 150 kDa で 5000 RU 以上）し、

マストランスポートリミテーション条件下で測定を実施します。固定化量が多い表面にお

いて、初期結合速度は、アナライトの分子量（Mw）、マストランスポート係数（km）、アナ

ライト濃度（Conc）で決定されます。このため、上記の初期結合速度（d[R] / dt）の関数を

利用してサンプル中のアナライト濃度を算出することができます。 

測定は、アナライトを最低 2 流速（5 および 100 µl/min を推奨）で添加して、センサーグラ

ムから初期結合速度を求めます。マストランスポート係数（km）は、拡散係数（D）、流速、

フローセル容積から計算できます。得られた 2 流速でのセンサーグラムを、1:1 結合モデル

で Kinetics 解析し、アナライトの分子量（Mw）、km値を定数とし、アナライト濃度をパラメ

ータとしてカーブフィッティングすることで濃度を算出します。なお、アナライトが抗体

（Bivalent Analyte）であっても、マストランスポートリミテーション条件下で、カーブフィ

ッティングが良好であれば、CFCAを実施することができます。 

 

参考文献： 

Christensen, Anal. Biochemistry （1997）249, p.153 

Sigmundsson, K., et. Al., Biochemistry （2002） 41, p.8263 

 

 

MW ：分子量（Da） 

km  ：マストランスポート係数 

= f （M
w

, km
, Conc） 

dt 
___ d[R] 

d[R] / dt 

5 ul/min 

100 ul/min 
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CFCA を実施するための至適条件 

① アナライト 分子量 ≧ 5,000Da 

② 結合速度定数（ka） 107 ＞ ka ＞ 5 X 104 M-1s-1 

③ 固定化量  できるだけ多く固定化します。 

 （分子量 150 kDa では、5,000 RU以上は必要。） 

④ アナライト濃度       CFCA で良好な結果が得られる濃度レンジは、0.5～50 nM です。

測定に用いるサンプル濃度は、1 μg/ml 程度が至適です。吸光度

（280 nm）による総タンパク質濃度を基準として調製します。

濃度が不明な場合には、10 倍希釈系列で 4 濃度以上調製してく

ださい。 

⑤ 流速 5 μl/min および 100 μl/min を推奨します。 

⑥ サンプルの性状 拡散係数や分子量が大きく異なる分子の混合溶液の場合には

CFCA は実施できません。 

 例）アナライトが IgG のポリクローナル抗体の場合には CFCA は

可能ですが、アナライトが IgGと IgMの混合溶液の場合にはCFCA

は実施できません。 

⑦ リファレンスセル リファレンスセルも設定し、リファレンスセルを差し引いたセ

ンサーグラムを利用して CFCA を実施します。 

⑧ 非特異的吸着 非特異的吸着が起きている場合に正確な濃度が算出できません。 

 

補足 4-11. マストランスポート、マストランスポートリミテーションとは 

マストランスポートとは、フローセルを流れる溶液中からセンサーチップ表面への、アナ

ライトの拡散現象を表します。アナライトのセンサーチップ表面への拡散（供給）速度は、

次式で求められます。 

アナライトの拡散速度（mol/m2s）＝アナライト濃度 × マストランスポート係数（km） 

 

D ：拡散係数  f  ：測定流速  h：フローセルの高さ 

 w ：フローセルの幅 l ：フローセルの長さ 

なお、アナライトの拡散速度よりも、センサーチップ表面のリガンドとの結合速度が速い

場合、マストランスポートが結合速度を制限するため、マストランスポートリミテーショ

ンが起きているといえます。リガンドの固定化量が多い場合には、マストランスポートリ

ミテーションが起きやすいです。 

km = 0.98 × √  0.3 × h2 × w × l  

 

D2 × f 3 
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補足 4-12. 拡散係数の求め方 

CFCA を実施する場合、20℃における拡散係数がパラメータとして必要です。 

拡散係数は、分子のサイズと形状によって決定され、次式によって算出できます。 

 

  

 

 

f   ：摩擦率 

    rel   ：20℃での水に対するアナライト溶媒の粘性 

   Mw  ：分子量（Da） 

 

なお、以下の方法でも拡散係数を得ることができます。 

① Biacore ウェブの Biacore T200 の拡散係数算出ツール 

② 文献値 

③ 実験的に算出（超遠心分析や光散乱分析など） 

 

Biacore ウェブの Biacore T200 の拡散係数算出ツールによる拡散係数の求め方 

 

次のアドレスにアクセスします。 

http://www.biacore.com /diffusion_calculator  

↓ 

 

 

ユーザー名（User ID）とパスワード（Password）を入力して、LOGIN をクリックします。（事

前に、ユーザー登録が必要です。） 

↓ 

D =  
324.3×10-11 

f× rel×Mw
1/3 （m2/s） 
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画面上で、20℃における拡散係数を算出します。 

① Molecular weight: 分子量（Da）を入力します。 

② Friction ratio:  摩擦率。 

○Choose molecular shape にチェックを入れ、 

の▼をクリックして該当の値を

選択します。以下の、3 項目から選択できます。 

・ Globular （1.2）・・・球形のタンパク質（初期設定値） 

例）抗体など 

・ Moderately elongated （1.7）・・・長いタンパク質  

例）フィブロネクチンやプラスミノーゲンなど 

・ Elongated （2.5）・・・硬く、長いタンパク質 

例）フィブリノーゲンやトロポミオシンなど 

① 

②

① 

③

① 

④ 
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○ Enter value にチェックを入れると、任意の値を入力できます。 

③ Viscosity relative to water at 20℃ 

 20℃における水に対するアナライト溶媒の粘性。○ Use standard 

value （1.00）にチェックを入れると、粘性係数を 1 とします。

（初期設定値） 

○ Enter value にチェックを入れると、任意の値を入力できます。 

 

①～③の設定が終了したら、 をクリックし計算を実行します。④に計算結果

が表示されます。 

 

 

画面下では、任意の温度における拡散係数から、20℃における拡散係数を算出することが

できます。文献や実測によって、20℃以外での拡散係数が得られている場合にも利用でき

ます。 
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4-2-1. プログラムの実行 

Toolbar の Run Method アイコン（  ）または Menu bar の Run → Method をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

 

Biacore Methods を選択した後、Open をクリックします。 

↓ 

 

↓ 

 

 

 

 

 

 

 

 

Calibration-Free Concentration を選択した後、Open をクリックします。 

↓ 

Method Builder の Main ダイアログが表示されます。Overview 画面にはメソッド全体の設定

項目が表示されます。以下に変更項目について記載します。詳細は BiacoreT200 日本語取扱

説明書 基本操作編を参照してください。 

↓ 

General Settings をクリックします。 
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① Data Collection rate 

10Hz を選択します。 

② Detection 

検出モードを以下の 2 つ（Dual,Multi）から選択します。 

Dual 2-1、4-3 

Multi 2-1,4-3、2-1,3-1,4-1 

③ Sample compartment temperature 

サンプルコンパートメントの温度（4～45℃）を設定します。通常は、25℃。 

④ Concentration unit 

  アッセイ全体を通して用いる濃度単位を選択します。 

⑤ Buffer settings 

  使用するランニング緩衝液名を入力します。 

⑥ After run 

チェックを入れておくと、全測定が終了した後に、センサー表面の温度が指定し

た温度に自動変更されます。 

設定後、Assay Steps をクリックします。 

↓ 

 

① ② ③ 

④ ⑤ 

⑥ 
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① Startup を選択します。 

② 下記のように設定します。 

Number of replicates 

times ベースライン安定化のためのスタートアップの測定回数

を指定します。3 回以上を推奨します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 
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① Sample を選択します。 

② 下記のように設定します。 

Number of replicates 

 times  繰り返し測定回数を選択します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 
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① blank を選択します。 

② 下記のように設定します。 

Recurrence  ○Distribute にチェックを入れ、occurrences evenly で 1 を選択。 

   全測定サイクル内で、均等にブランクの測定を実施します。 

Number of replicates 

 times  繰り返し測定回数を選択します。 

↓ 

Cycle Types をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

① 

② 
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① Startup をクリックします。アナライト測定前のスタートアップの詳細を設定します。 

② Commands タブの Sample1 をクリックします。 

③ Settings for Sample1 でスタートアップ用サンプル（Buffer）添加の詳細条件を設定します。

測定流速以外は、サンプル添加と同一条件を設定します。 

Type    High performance を選択します。 

contact time   添加時間（s）。基本は 36 秒です。 

Dissociation time   解離時間（s）。基本は 5 秒です。 

Flow rate    流速（μl/min）。基本は 30 μl/min です。 

Flow path   Both を選択します。 

Sample solution   Buffer （ランニング緩衝液） 

 

④ 引き続き、Commands タブの Regeneration1 をクリックします。 

⑤ 再生条件を設定します。 

Regeneration solution  再生溶液名を入力します。 

contact time   添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   Both を選択します。 

 

↓ 

① 

② 

③ 

④ 

⑤ 



 
 

4. 濃度測定   103 

 

Biacore T200 

日本語取扱説明書 

 

① Cycle types currently in Method の Sample をクリックします。 

② Commands タブの Sample1 をクリックします。 

③ Settings for Sample1 でサンプル添加の詳細条件を設定します。 

Type    High performance を選択します。 

contact time   添加時間（s）。基本は 36 秒です。 

Dissociation time   解離時間（s）。基本は 5 秒です。 

Flow rate Is variable に設定されています。実数は、Setup Run の

Variables で入力します。 

Flow path   Both を選択します。 

 

④ 引き続き、Commands タブの Regeneration1 をクリックします。 

⑤ 再生条件を設定します。 

Regeneration solution  再生溶液名を入力します。 

contact time   添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   Both を選択します。 

 

↓ 

Variable Settings を選択します。 

① 

② 

③ 

④ 
⑤ 
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Assay Steps の Sample をクリックします。画面右上で、○ Define some values in Method and 

others at run time. にチェックを入れます。下記の 5 項目については、Setup Run 以降の

Variables で入力します。 

Sample solution  サンプル名 

Flow rate （μl/min） 同一サンプルで、5 μl/min と 100 μl/min の 2 流速を設定します。 

MW（Da）  分子量 

D（20℃）  20℃における拡散係数 

Dilution   サンプルの希釈倍率 

 

以下について、画面下で設定します。 

Blank 解析時のキーワードとして利用します。ブランクサンプルか否か

を指定します。サンプルの場合には、”No”または“n”を入力しま

す。 

 

↓ 
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Assay Steps の Blank をクリックします。画面右上で、○ Define some values in Method and 

others at run time. にチェックを入れます。Flow rate （μl/min）については、Setup Run 以降

で入力します。 

 

画面下で、下記の項目について入力します。 

Sample solution  “Buffer”と入力します。 

MW（Da）  未入力 

D（20℃）  未入力 

Blank ブランクサンプルの場合には、”Yes”または“y”を入力します。 

Dilution   未入力 

 

↓ 

Verification をクリックします。 

↓ 
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メソッドの設定に不備が無ければ“The Method has been verified and can be used to set up a 

run.”と表示されます。問題が有る場合は該当部分が表示されるので、指示に従って修正しま

す。確認後、Setup Run をクリックします。

↓ 

 

 

 

 

 

適切な Flow path を選択し、Next をクリックします。 

↓ 
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Sample をクリックします。下記項目について入力します。 

Sample solution  サンプル名 

Flow rate （μl/min） 同一サンプルで、5 μl/min と 100 μl/min の 2 流速を設定します 

Mw（Da）  分子量 

D（20℃）  20℃における拡散係数 

Dilution   サンプルの希釈倍率 

 

↓ 
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引き続き、Blank をクリックします。 

Flow rate （μl/min） Sample と同一の流速を設定します 

設定後、Next をクリックします。 

↓ 

測定サイクルリストが表示されます。 
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Next をクリックします。 

↓ 

 

 

 

 

 

 

 

測定を始める前に、Prime および Normalize をおこなう場合にはチェックを入れます。 

入力後、Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 

 

補足 4-13. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu → Export Positions…

を実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を

変更した後ファイルを保存し、Menu → Sample Position Import…でそのファイルを読み込む

と、サンプル位置が変更されます。
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補足 4-14. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分注して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ
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れらも必要に応じて適宜設定を変更します。

Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。Eject Rack Tray ダイアログが閉じた

後、Rack Positions ダイアログ右下の Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したメソッドをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

 

 

 

 

 

 

 

 

 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

↓ 

終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動保存され、Biacore T200 Evaluation Software が自動

的に起動して、各サイクルの測定結果が重ね書き表示されます。
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補足 4-15. プログラムの緊急停止 

Run→Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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4-2-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

補足 4-16. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 4-17. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline  サンプル添加直前の AbsResp 

Binding level  サンプル添加時の Baseline からの RelResp 

Binding stability  サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

 

 

 

 

 

 

 

Sensorgram window 
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Toolbar の をクリックし、 をクリックします。 

↓ 

 

画面上の表に、測定したサンプル情報が、測定サイクル順に表示されます。 

Cycle#   測定サイクル番号 

Curve   カーブタイプ 

Ligand   リガンド名 

Sample   アナライト名 

Dilution factor  希釈倍率 

Flow （μl/min）  測定流速 

Initial rate （RU/s） 添加開始後 7.5～12.5 秒の 5 秒幅の結合速度（自動計算されます） 

QC ratio   QC 比（自動計算されます） 

Temp （℃）  測定温度 

MW （Da）  分子量 

D （m2/s）  測定温度における拡散係数（自動計算されます） 

Blank used  ブランクとして利用しているセンサーグラムのサイクル番号 
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なお、画面上部の Expand all cycles のチェックを外すと、サンプル情報表の表示がサンプル

名別のリストに変更します。 リファレンスセルを差し引かないセンサーグラムで解析する

場合には、Use reference subtraction data のチェックを外します。  

↓ 

画面左下の、 をクリックして、ブランクを確認します。 

 
センサーグラムを確認して、エアーの混入や形状がおかしいブランクは、画面上表の Include

のチェックを外します。ブランクセルは差し引かなくても解析は可能です。ブランクを利

用しない場合には、Include のすべてのチェックを外します。 

選択後、OK をクリックします。 

↓ 

解析に利用できるセンサーグラムを選択します。 

 

補足 4-18. CFCA に利用するセンサーグラムの選択基準 

CFCA では、マストランスポートリミテーション条件下のセンサーグラムを解析に利用しま

す。以下の評価基準を満たすセンサーグラムを解析に利用します。 

① 低流速の初期速度（Initial rate （ RU / s ） ）= 0.2～15 （ RU / s ） 

   ＜ 0.2 RU / s では、レスポンスの上昇量が低いため良好な結果が得られません。 

  ＞ 15 RU / s では、マストランスポートリミテーションが十分ではない可能性があります。 

② QC ratio ≧ 0.2 
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＜ 0.2 の場合には、マストランスポートリミテーションが十分ではありません。 

 

解析に利用しないセンサーグラムは、Include のチェックを外します。 

 

選択したセンサーグラムを確認したい場合には、画面中央の 

 

で選択します。▼をクリックしてセンサーグラムを選択します。Show blank subtracted data

のチェックを外すと、リファレンスセルと差し引き前のセンサーグラムを確認できます。 

画面右下の Advanced settings をクリックします。 

↓ 

 

選択したセンサーグラムの重ね書きが表示されます。 

Settings の○Single Sample series にチェックを入れ、 
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の▼をクリックしてサンプルを選択すると、各サンプルのセンサーグラムの重ね書きに変

更できます。 

サンプル添加開始 10 秒前から、添加終了 5 秒前の範囲（青いラインで表示）で解析します。

この範囲にエアーの混入などによるノイズが確認できる場合には、該当部位を削除します。 

（補足 4-19 参照）Close をクリックします。 

↓ 

Next をクリックします。 

 

補足 4-19. センサーグラムの部分的削除 

エアーの混入などで、センサーグラムが乱れている部分は、以下の方法で削除します。 

マウスの左ボタンをドラッグし、該当の領域を拡大した後、マウスの右ボタンをドラッグ

して削除する領域を選択します。拡大図を解除する場合は、白い部分をダブルクリックす

ると、一つ前の縮小画面に戻ります。 

 

領域をクリックすると、グラフ右上の Remove Selection ボタンがアクティブになります。ク

リックすると、選択部位が削除されます。Undo をクリックすると、削除前に戻ります。 
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解析が始まります。 

↓ 

 

解析が終了すると、画面上部に各サンプルの結果が表示されます。 

Meas.Conc （ M ）  解析によって算出された濃度 

▼をクリックすると単位変更が可能です。 
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Calc.Conc （ M ） 希釈倍率を Meas.Conc に掛けた濃度 

QC ratio QC 比 

Chi2 （ RU2 ）  カイ二乗 

SE （ Meas.Conc ） Meas.Conc の標準誤差 

 

解析結果の評価については、補足 4-20 を参照してください。 

Finish をクリックします。 

↓ 

上記解析結果が、Evaluation Explorer 中のフォルダに追加保存されます。 

 

補足 4-20. CFCA の解析結果の評価 

以下の基準を満たしている場合には、良好な結果と判断できます。 

① カーブフィッティングが良好である 

フィッティングが良好な場合、カーブフィッティングによって得られた黒色のセンサー

グラムが、測定センサーグラムと一致します。Chi2値が、低流速のセンサーグラムの解

離直前の結合量の 5%以下であれば、フィッティングが良好と判断できます。  

 

② SE（standard error）が解析結果濃度の 20%以下 

SE が算出濃度の 20%以下であれば問題ありません。 

 

③ 解析結果濃度が、0.5～50 nM の範囲内である 

範囲外の場合には、①、②の基準にパスしていても結果の取り扱いに注意が必要です。 

 

補足 4-21. ファイル名の変更 

Evaluation Explorer 中の目的ファイルをクリックします。 

↓ 

 

上記状態で、キーボードの Backspace キーで、ファイル名を一度削除し、新たに新規ファイ

ル名を入力します。 

↓ 
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5. 熱力学的パラメータの算出 
 

熱力学的解析 

熱力学的パラメータは、分子同士の相互作用メカニズム解析に対して重要な情報を提供し

ます。Biacore では、熱力学的パラメータは、複数の温度条件で速度論的相互作用解析を実

施することで算出できます。平衡状態における熱力学的パラメータ（ΔG゜、ΔH゜、ΔS゜）

のみならず、遷移状態における熱力学的パラメータ（ΔG゜‡、ΔH゜‡、ΔS゜‡）も算出するこ

とが可能です。平衡状態におけるパラメータからは“その分子同士がその強さで結合する理

由”、遷移状態におけるパラメータからは“その分子同士がその速度で結合、解離する理由”

を議論することができます。 

 

例として、ある抗原と抗体（野生型と 2 種類の変異型）の相互作用を紹介します。 

通常の速度論的解析では、ある温度で相互作用測定を実施し、算出された反応速度定数の

比較から野生型と変異型の結合および解離速度の違いを知ることができます。さらに、熱

力学的解析の結果からは、下図に示したように、変異型 2 の ΔH゜‡と ΔS゜‡が野生型および

変異型 1 のそれらとは大きく異なっていることがわかります。すなわち、変異型 2 は野生

型および変異型 1 とは異なった様式で相互作用していることが示唆されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

熱力学的パラメータの解析手順 

数段階の温度（4 段階以上）において同一分子間のカイネティクス解析を実施し、解離定数

（KD）、反応速度定数（ka, kd）を算出します。 

平衡状態、遷移状態における熱力学的パラメータ算出には、それぞれ次式を応用していま

す。各温度において算出した解離定数（KD）、反応速度定数（ka, kd）を代入します。 

R
e
s
p

o
n

s
e
 (

R
U

)

13°C

45°C

13°C

29°C

37°C

45°C

21°C

R
e
s
p

o
n

s
e
 (

R
U

)

13°C

45°C

13°C

29°C

37°C

45°C

21°C

R
e
s
p

o
n

s
e
 (

R
U

)

13°C

45°C

13°C

29°C

37°C

45°C

21°C

-TS

-100

-80

-60

-40

-20

0

20

40

60

A+B A--B AB



wt

mut 1

mut 2

−S°‡

k
J
/m

o
l

-TS

-100

-80

-60

-40

-20

0

20

40

60

A+B A--B AB



wt

mut 1

mut 2

−S°‡

k
J
/m

o
l

-TS

-100

-80

-60

-40

-20

0

20

40

60

A+B A--B AB



wt

mut 1

mut 2

−S°‡

k
J
/m

o
l

G

-100

-80

-60

-40

-20

0

20

40

60

A+B A--B AB



wt

mut 1

mut 2

G°‡

k
J
/m

o
l

G

-100

-80

-60

-40

-20

0

20

40

60

A+B A--B AB



wt

mut 1

mut 2

G°‡

k
J
/m

o
l

H

-100

-50

0

50

100

A+B A--B AB



wt

mut 1

mut 2

H°‡

k
J
/m

o
l

H

-100

-50

0

50

100

A+B A--B AB



wt

mut 1

mut 2

H°‡

k
J
/m

o
l

野生型 変異型 



 
 

5. 熱力学的パラメータの算出   123 

 

Biacore T200 

日本語取扱説明書 

平衡状態における熱力学的パラメータ算出 

van’t Hoff 式を応用します。各温度における解離定数（KD）を代入し、各種パラメータを算

出します。線形解析と非線形解析により算出可能です。 

 

線形解析 

ΔG°= RT lnKD  

ΔG°= ΔH°- TΔS°  

lnKD = ΔH°/ RT - ΔS°/ R 

 

ΔG° 自由エネルギー変化（kJ/mol） 

R 気体定数 

T 絶対温度（K） 

KD 解離定数（M） 

ΔH° エンタルピー変化（kJ/mol） 

ΔS° エントロピー変化（J/K・mol） 

 

非線形解析 

 

ΔCp 熱容量変化（kJ/K・mol） 

T0 基準温度（標準状態では 25℃） 

 

遷移状態における熱力学的パラメータ算出 

Eyring 式を応用します。各温度における反応速度定数（ka, kd）を代入し、各種パラメータを

算出します。 

 

k = （ kBT / h ）exp（ ΔS゜‡ / R - ΔH゜‡ / RT ） 

ln k / T = ΔS゜‡ / R - ΔH゜‡ / RT + ln kB / h 

 

k 各反応速度定数 

kB ボルツマン定数 

h プランク定数 

ΔS゜‡ エントロピー変化（J/K・mol） 

R 気体定数 

ΔH゜‡ エンタルピー変化（kJ/mol） 

T 絶対温度（K） 

ΔG゜‡ 自由エネルギー変化（kJ/mol 
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5-1. プログラムの実行 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run→Wizard をクリックします。 

 

Assay→Thermodynamics を選択した後、New をクリックします。以前にプログラムを

Methods and Templates フォルダに保存している場合は、右側の一覧表に反映されます。同

じプログラムを実行したい場合は、Open をクリックします。別のフォルダに保存されてい

るプログラムを実行したい場合は、Browse をクリックし、目的のプログラムをハイライト

にして Open をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 サイクル分の測定シークエンスを設定します。
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Detection 

Flow path  2-1 もしくは 4-3 を設定します。 

Chip    

 Chip type  利用するセンサーチップを選択します。 

Capture 

アナライトの添加前に、固定化したキャプチャー分子に対して、リガンドを捕捉

する場合にチェックを入れます。リガンドは、フローセル 2 もしくはフローセル 4

にキャプチャーされます。 

Sample 

アナライトの添加コマンドです 

Regeneration 

再生が必要な場合にチェックを入れます。添加回数を選択します。（1 or 2） 

Carry Over 

 アナライトのキャリーオーバーを確認する場合にチェックを入れます 

 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Conditioning 

Solution  再生溶液または緩衝液の名称 

contact time 添加時間（s）
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Number of injections 添加回数 

Startup 

Solution  指定した溶液で、相互作用測定と同様の工程をアナラ

イト測定前に実施します。通常は、ランニング緩衝液を

用います。 

Number of cycles サイクル数。3 回以上を推奨します。 

Solvent correction   

低分子化合物がアナライトで溶媒補正が必要な場合にチェックを入れます。 

    Number of injections 溶媒補正の測定点を選択します。何サンプルごとに溶媒

補正を実施するかを、 ”Repeat after     Sample 

cycles”で指定します。 

Temperatures 

Analysis temperatures 検出部位の温度を設定します。25℃を真ん中に、5 点以

上を推奨します。 

Sample compartment temperatures 

サンプルコンパートメントの温度を入力します。 

Next をクリックします。 

↓  

 

Sample 

contact time  アナライトの添加時間 120 s 

Flow rate                流速                    30 μl/min 

Dissociation time  解離時間  120 s 

 Extra wash after injection with 

アナライト添加後に指定した溶液で、フローセル以外

の流路を洗浄したい場合にチェックを入れます。セン

サーチップ表面には流れません。

Regeneration 

Solution   再生溶液の名称 
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High viscosity solution 粘性の高い溶液（40%エチレングリコール以上）の場合

に選択します 

contact time  再生溶液の添加時間 60 s 

Flow rate   流速   30 μl/min 

Stabilization period 添加後のベースライン安定化時間 0 s 

   （必要に応じて設定します） 

 

入力後、Next をクリックします。 

↓ 

 

Sample id  アナライトの名称 

MW （Da）  アナライトの分子量 

Concentration  アナライトの濃度（単位も選択） 

分子量と濃度を入力すると、自動的に“モル濃度 nM ”と

“重量濃度 μg/ml”を換算します。 

入力後、Next をクリックします。 

↓ 

補足 5-1. Excel ファイルで作成したサンプル情報の入力 

Excel ファイルで作成したサンプル情報を移行するには、Excel での保存時、タブ区切りのテ

キストファイル（拡張子は txt）を選択します。タブ区切りで保存したデータを上記画面で

開き、コピーペーストで入力します。 
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測定を始める前の Prime および Normalize の実施を選択します。 

↓ 

 

右側の表でサンプルの位置と容量（μl）を確認します。表中のサンプルをクリックするとそ

れに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイアルお

よびサンプルをラックにセットします。

補足 5-2. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 
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補足 5-3. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分別して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。 
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Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。 

Eject Rack Tray ダイアログが閉じた後、Rack Positions ダイアログ右下の Next をクリックし

ます。  ↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 
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Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

↓ 

 

 

 

 

 

 

 

 

設定温度に達するまで、上記ウインドウが表示されます。設定温度に達すると測定が開始

されます。 

↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動します。 

補足 5-4. プログラムの緊急停止 

Run→Stop Run をクリックします。 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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5-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

補足 5-5. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 5-6. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline  サンプル添加直前の AbsResp 

Binding level  サンプル添加時の Baseline からの RelResp 

Binding stability  サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

 

 

 

 

 

 

 

Sensorgram window 
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各温度における解離定数（KD）、反応速度定数（ka,kd）を算出します。 

詳細は BiacoreT200 日本語取扱説明書 基本操作編を参照してください。 

 

Toolbar の をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

同一温度、同一サンプル名のセンサーグラムがすべて重ね書き表示されます。 

 

Select Evaluation mode で Single mode を選択します。 

Next をクリックします。 

↓ 
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濃度 0 のセンサーグラムが、ブランクとして、全センサーグラムから差し引かれます。 

Kinetics をクリックします。 

↓

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Model:に、1:1 Binding を選択します。Fit をクリックします。 
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Finish をクリックします。 

↓ 

上記解析結果が、Evaluation Explorer 中のフォルダに追加保存されます。ファイル名は自動

的にサンプル名が採用されます。 

この実験では、測定温度を変化させて、同一サンプルで同様の実験を行うため、どの温度

についての解析結果も同一ファイル名（サンプル名）で保存されます。混乱を避けるため、

この時点でファイル名を変更することを推奨します。 

補足 5-7. ファイル名の変更 

Evaluation Explorer 中の目的ファイルをクリックします。 

↓ 

 

上記状態で、キーボードの Backspace キーで、ファイル名を一度削除し、新たに新規ファイ

ル名を入力します。 

↓ 
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同様に、別の温度の測定データについても解析します。 

Toolbar の をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Temperature 右側の をクリックします。温度を変更し、反応速度定数（ka,kd）を算出しま

す。 

↓ 

すべての温度について解析終了後、Toolbar の をクリックします。自動的に

全解析結果がテーブルに表示されます。 
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Import をチェックし、Thermodynamics に利用するデータを選択します。Check All をクリ

ックするすると、全データが選択されます。Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

温度に対する解離定数、反応速度定数のプロットが表示されます。Next をクリックします。
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

から、線形解析（Linear）または非線形解析（Non-linear）を選択します。 

選択した解析手法の結果が表示されます。 

すべての熱力学的パラメータは、左上のテーブルに表示されます。 

 

Finish をクリックします。 

上記解析結果は、Evaluation Explorer 中の Thermodynamics フォルダに追加されます。ファイ

ル名は自動的にサンプル名が採用されます。 
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6. 結合アナライトの回収 
 

固定化したリガンドに対して結合したアナライトを回収します。再生溶液を添加し、溶出

されたアナライトを引き戻すようにして指定したバイアルに回収します。1 回の回収容量は

およそ 2 µl です。効率よく回収するためには、アナライトの添加条件と回収溶液の条件が重

要となります。 

 

アナライトの添加条件 

できるだけ高濃度のアナライトを用いる方が、1 度の添加でより効率よくアナライトを回収

することができます。特に低親和性の結合ではアナライト濃度が回収率に大きく影響しま

す。血清等のアナライトの添加では、センサーチップ表面へ非特異的吸着が生じやすく、

目的分子以外の分子も回収されます。このような場合には、希釈倍率をあげて非特異的吸

着を低減させるなどの検討が必要となります。また、1 度に回収される量は微量であるため、

結合量から、何回程度繰り返し結合回収が必要か確認する必要があります。 

 

回収溶液 

再生溶液が回収溶液となります。再生できなければ、アナライトを回収することができな

いので、あらかじめ、マニュアル測定で再生条件を検討します。 

質量分析に回収サンプルを直接持ち込む場合は、サンプルを酸性化することが必要です。

低濃度の酸は、結合したアナライトを再生するのに適している場合が多く、回収溶液に 0.5 % 

TFA や 0.1 %酢酸を利用すれば、回収サンプル溶液を直接質量分析で解析することができま

す。質量分析の前に ZipTip（Milipore）などのマイクロ逆相カラムで精製する場合には、回

収溶液として、アルカリ溶液（50 mM NaOH など）も使用できます。 

 

回収前の洗浄溶液 

相互作用測定時の緩衝液には、質量分析を阻害する成分（例；NaCl、Surfactant P20、DMSO、

リン酸緩衝液など）が多く含まれています。回収サンプル溶液中への、これらの成分の混

入を抑えるために、アナライト添加直前にセンサー表面や流路を洗浄する必要があります。

その洗浄溶液として、炭酸水素アンモニウムなどの揮発性の緩衝液が用いられます。 
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6-1. プログラムの実行 

Toolbar の Run Method アイコン（  ）または Menu bar の Run → Method をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

Biacore Methods をダブルクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

Inject and recover をハイライトにし、Open をクリックします。 

↓ 

Method Builder の Main ダイアログが表示されます。 

Overview 画面にはメソッド全体の設定項目が表示されます。以下に変更項目について記載

します。詳細は BiacoreT200 日本語取扱説明書 基本操作編を参照してください。 
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General settings をクリックします。 

↓ 
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① Data Collection rate 

1Hz を選択します。 

② Detection 

Multi を選択します。設定の変更不可。1、2、3、4 に流れます。 

③ Sample compartment temperature 

サンプルコンパートメントの温度（4～45℃）を設定します。通常は、25℃。 

④ Concentration unit 

アッセイ全体を通して用いる濃度単位を選択します。 

⑤ Buffer settings 

使用するランニング緩衝液名を入力します。 

⑥ After run 

チェックを入れておくと、全測定が終了した後にセンサー表面の温度が指定した

温度に自動変更されます。 

 

設定後、Assay Steps をクリックします。 

↓ 

 

① ② ③ 

④ ⑤ 

⑥ 
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Surface conditioning をクリックする。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Number of replicates 

 Times  スタートアップの測定回数を指定します。3 回以上を推奨します。 

↓ 

Injection and Recover をクリックします。 

↓ 
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Number of replicates 

 Times   回収サイクルの実施回数を入力します。 

 

Cycle Types をクリックし、次画面に移動します。 

↓ 



 
 

146   6. 結合アナライトの回収  

Biacore T200 

日本語取扱説明書 

Inject and Recover をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sample solution   アナライトの名称 

contact time   アナライト添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   1, 2, 3, 4。変更不可。 

Wash solution  アナライト添加前のフローシステムの洗浄溶液 

Recovery solution   マニュアル測定で条件検討した再生溶液を入力します。

    回収溶液は、ランニング緩衝液との希釈を防ぐために

    エアーセグメントをはさんでフローセルに添加されま

    す。フローセルに到達したところで流速は 0 になり、

    接触時間（Incubation time）分留まります。 

Incubation time   回収溶液の接触時間（s）を入力します。 

Deposition solution  回収溶液を中和する緩衝液を入力します。また、トリ

プシンやプロテアーゼも使用可能です。 

アナライト添加前に、回収先となるバイアルに設定容量

分を自動分注します。 

Deposition solution volume  中和溶液の分注量（μl）を指定します。 

Number of repetitions  1 サイクル中の添加・回収回数を入力します。最大 10 

    回まで可能です。回収量を稼ぎたい場合に設定します。
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↓ 

Conditioning をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

回収サイクル前のセンサーチップのコンディショニング条件を設定します。 

Regeneration solution  再生溶液を入力します 

contact time   添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   1, 2, 3, 4 を選択します 

Setup Run をクリックします。 

↓ 

 

 

 

 

 

Flow path:   1, 2, 3, 4 を選択します 

Next をクリックします。 

↓ 
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測定サイクルリストが表示されます。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

測定を始める前の Prime および Normalize の実施を選択します。 

Temperature settings 

Analysis temperature   25 ℃ 

Sample compartment temperature  25 ℃ 

 

Next をクリックします。 

↓ 
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右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 
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補足 6-1. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分注して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning…を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。 
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Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。 

Eject Rack Tray ダイアログが閉じた後、Rack Positions ダイアログ右下の Next をクリックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したメソッドをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 
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Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

↓ 

測定終了後、装置は Standby flow 状態になります。 

 

 

補足 6-2. プログラムの緊急停止 

Run→Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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回収のセンサーグラム 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

回収の評価 

1000 RU は約 1 ng/mm2の質量変化に相当します。 

回収操作終了後 60 秒後に、結合レスポンス（bound）を相対値 0 として計算した回収レス

ポンス（recovered）が得られます。4 つのフローセルの面積の合計は約 5.8 mm2なので、何

ng 回収できたかを推測することができます。回収レスポンスは、測定結果のレポートポイ

ントテーブルを参照してください。 

 

 

 

 

 

 

回収 

フローシステムの洗浄 

アナライト添加 

エアー 

セグメント 

回収量 
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7. 免疫原性試験 
 

人体が異質なタンパク質にさらされると、免疫応答が起こります。慎重に設計され、構築

されたタンパク質治療薬でも、異質なタンパク質としてみなされ、治療薬を認識する抗体

の産生を引き起こすかもしれません。このような応答は治療効果を低下させ、場合によっ

ては生命に係わる免疫反応を惹起します。今日、タンパク質治療薬の開発において抗薬物

抗体 (Anti drug Antibodies: 以下 ADAs と略します) の測定は申請の必須項目となっています。 

Biacore T200 を用いた ADAs の検出では、Drug-ADAs 複合体を一時的に解離した状態で測定

するMerged Inject法または Double Mix法を使用することで、ADAsを高感度に検出できます。

血中に存在する薬物の濃度や、抗体のアフィニティーに関係なく、安定的な ADAs の検出を

行うことができます。さらに、免疫原性試験スキームとして、阻害法による擬陽性の確認

試験、ADAs のアイソタイプの同定試験、ADAs の成熟度（結合安定性）の確認試験があり

ます。 

 

Merged Inject 法 

Drug – ADAs 複合体を酸性化することで、ADAs を薬物から解離させた後、薬物（リガンド）

を固定化したフローセルに流れる直前に、中和溶液と混合してサンプル溶液を中性化後、

添加する方法です。フローセル 1 およびフローセル 2 を通る間に中和溶液と混合しますの

で、リガンドはフローセル 3 に固定化します。ADAs の結合速度が速く、中和後、薬物と速

やかに再結合する場合は、Merged Inject 法の利用を推奨します。 

 

 

 

 

 

 

 

 

 

図 1. Merged Inject 法のイメージ 
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Double Mix 法 

Drug – ADAs 複合体をマイクロプレートのウェル内で、酸性化および中和後にフローセルに

添加する方法です。ADAsの結合速度が遅く、中和後に再結合するまで時間がかかる場合や、

酸性化することで薬物が破壊され、複合体形成の可能性がない場合は、Double Mix 法が利用

できます。 

 

至適条件 

センサーチップ  固定化量を確保して非特異吸着を低減するため、Sensor Chip 

CM5 の使用を推奨します。 

 

リガンド固定化手法 固定化量を確保するため、アミンカップリング法を推奨します。 

 

固定化フローセル Merged Inject 法を使用する試験では、Fc3 と 4 にリガンドを固定

化してください。（Fc4 では ADAs と抗原が再結合して感度が低下

することがあるため、Fc3 での評価を推奨します。） 

 

リガンド固定化量 固定化量が多いほど検出感度が上がります。150 kDa 程度の分子

量であれば、7,000 RU～15,000 RU の固定化量を目指してくださ

い。 

 

リファレンスの差し引き サンプル添加後の結合レスポンスおよび解離領域で評価するた

め、必要ありません。ただし、センサーチップ表面への非特異的

図2. サンプル中の薬物濃度変化におけるADAs

の結合量の変化（酸性化/中性化なし） 

図3. サンプル中の薬物濃度変化におけるADAs

の結合量の変化（酸性化/中性化あり） 
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吸着を低減するためのサンプル処理が必要です。 

 

ランニング緩衝液 HBS-EP+を推奨します。 

 

サンプルの前処理 遠心またはフィルターろ過による不溶性成分の除去が必要です。

(Merged Inject 法を使用する場合には血清は希釈せずに使用しま

す。) 

 

非特異吸着の低減 血清サンプルは、血清中の夾雑物がセンサーチップ表面のデキ

ストランに非特異的吸着します。非特異的吸着を低減するため、

デキストラン（NSB Reducer；コード番号 BR-1006-91）をサン

プル溶液に混合してください（Merged Injection 法では効果が低

いため使用しません）。終濃度の目安は 1 mg/mL です。HBS-EP+

をランニング緩衝液として使用していない場合には、HBS-EP+に

相当する濃度の塩（150 mM NaCl）、界面活性剤（0.05% Surfactant 

P20）を混合してください。 

 

コントロールサンプル ネガティブコントロールとして、薬物が投与されていない血清

を使います。ポジティブコントロールとして、ネガティブコン

トロールに抗体を添加したものを使います。繰り返し測定によ

るリガンドの失活が起きている場合やリガンドへの非特異的吸

着が起きている場合には、それらの因子についてネガティブコ

ントロールおよびポジティブコントロールの結合量を利用して、

検体の結合量を補正することができます。補正するためには、1

測定につき 4 回、コントロールの測定を実施してください。ネ

ガティブコントロールおよびポジティブコントロールは 1 種類

あれば十分です。 

 

温度設定 Merged Injection 法では、測定温度が高いと酸性化サンプルがフ

ローセル 1 および 2 を通過する際にセンサーチップ表面に非特

異的吸着が起きます。温度が低い程、センサーチップ表面に対

する非特異的吸着を抑制できるため、Analysis temperature およ

び Sample compartment temperature はいずれも 10℃を推奨しま

す。 

 通常の添加および Double Mix 法を使用する測定では、Analysis 

temperature は 25℃ ｓSample compartment temperature は 10℃
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を推奨します。 

ただし、 10℃で沈殿する緩衝液成分や再生溶液（例：

guanidine-HCl）を使用する際には、ご注意ください。 

 

酸性化・中和溶液 Merged Injection 法 

   酸性化溶液；0.12 M HCl, 0.1 % Surfactant P20 

中和溶液；1.3 M Tris-HCl, 0.05 % Surfactant P20, pH 8.5 

＊固体の Tris-HCl を、終濃度 1.3 M になるよう超純水を用いて溶

解し、4 M NaOH を用いて pH 8.5 に合わせます。最後に Surfactant 

P20 を加えて調製します。使用期間は 1 週間です。 

 

   Double Mix 法 

   酸性化溶液；0.12 M HCl, 0.1% Surfactant P20 

中和溶液；1.0 M Tris-HCl, 0.05% Surfactant P20, pH 8.0 

＊固体の Tris-HCl を、終濃度 1.0 M になるよう超純水を用いて溶

 解し、4 M NaOH を用いて pH 8.0 に合わせます。最後に Surfactant 

 P20 を加えて調製します。使用期間は 1 週間です。 

 

再生条件  10 mM Gly-HCl pH1.5 – 2.5 の範囲で、30 秒添加することで再生で

きることが多いです。ただし、条件検討は必須です。条件検討で

は、ポジティブコントロールとして使用している抗体を用いてく

ださい。この時、抗体はランニング緩衝液に希釈したものを用い

ます。再生条件が決定できた上で、抗体をスパイクした血清を用

いて、再生条件の確認を行ってください。また、測定温度により

再生条件は異なるため、測定予定の温度で条件検討を行ってくだ

さい。 

 なお、再生溶液添加後には、20% isopropanol, 40mM NaOH による

Extra wash を実施してください。血清の流路への吸着を洗浄・除

去します。 

 

増幅試薬  ADAs の結合レスポンスが小さく、評価しにくい場合は、2 次抗

体など用いて、結合量を増幅させることができます。ADAs のア

イソタイプやサブクラスなどが不明な場合は、考えられるアイソ

タイプやサブクラスに対する 2 次抗体を混合した溶液を用いて

ください。リガンドとして固定化している薬物が抗体であれば、

抗human IgG lambda抗体や抗human IgG kappa抗体を用いること
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もできます。 

 

システムのメンテナンス 測定終了ごとに、Desorb を実施してください。月に 1 度、Desorb 

and Sanitize およびシステムチェックを実施してください。 

 

Cut-off 値の計算方法 ネガティブコントロールサンプルのレスポンスの平均値 + SD

（標準偏差）x 1.645 

（ネガティブコントロールとして、95 %信頼できる値として計

算した場合の式となります。参照文献 Mire-Sluis, A. R. Et al 2004, J. 

Immunol.Methods 289, 1-16） 

 

なお、wizardの Immunogenicity Screeningおよび Immunogenicity Isotypingで、Merged Injection

または Double Mix 法を使用する場合には、96 well microplate のみ使用できます。（384 well 

microplate は使用できません。）  
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7-1. スクリーニング 

7-1-1. プログラムの実行（Merged Inject 法の場合） 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run → Wizard…をクリックしま

す。 

 

Immunogenicity → Immunogenicity Screening を選択した後、New をクリックします。以

前にプログラムを Methods and Templates フォルダに保存している場合は、右側の一覧表に

反映されます。同じプログラムを実行したい場合は、Open をクリックします。別のフォル

ダに保存されているプログラムを実行したい場合は、Browse をクリックし、目的のプログ

ラムをハイライトにして Open をクリックします。 

↓ 

 

 

 

 

 

 

 

○Acidification and neutralization にチェックします。Next をクリックします。 

↓ 
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1サイクル分の測定シークエンスを設定します。Enhancementおよび Regenerationの回数は、

条件に合わせて設定します。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

ダミーランを設定します。ダミー用のサンプルは、ポジティブコントロールを用います。3

回以上の実施を推奨します。 

Next をクリックします。 

↓ 
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それぞれの項目における溶液名、添加時間、流速を入力します。（上記画面は、2 次抗体の

添加、2 種類の再生溶液の添加を想定した例となります。）Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

サンプル名を入力します。Cut-off 値を決めるためのネガティブコントロールサンプルは、

サンプル名に blank と入力すると、測定値を抽出するのに便利です。Run order を設定し、

Next をクリックします。 
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

コントロールサンプルを測定する場合は、Run control samples をチェックし、さらに繰り返

し測定する場合は、Run control sample(s) every をチェックします。測定頻度は、10 サンプル

もしくは 20 サンプル毎が推奨です。コントロールサンプル名を入力し、Next >をクリック

します。 

↓ 

 

 

 

 

 

 

 

 

温度が低いほど非特異吸着を抑制できるため、Analysis temperature および Sample 

compartment temperature いずれも 10℃を推奨します。ただし、10℃にすることで沈殿する

溶液もあるため、注意が必要です。（例；guanidine-HCl は 10℃で沈殿します。）最後に測定

の流れを確認する場合は、Cycle Run List をクリックします。Next をクリックします。 

↓ 
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 

補足 7-1. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions

を実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を

変更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込む
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と、サンプル位置が変更されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。Start をクリッ

クします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

 ↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動して、各サイクルの測定結果が重ね書き表示されます。
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補足 7-2. プログラムの緊急停止 

Run→Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押してください。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 
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7-1-2. プログラムの実行（Double Mix 法の場合） 

7-1-1 章に従い、Immunogenicity Screening ウィザードを用いてプログラムを作成し、保存し

ます。保存したウィザードを用いて、メソッドによりプログラム内容を変更します。 

Toolbar の Run Method アイコン（  ）または Menu bar の Run→Method をクリックしま

す。 

↓ 

 

 

 

 

 

 

 

 

 

ウィザードを保存したフォルダを指定し、Show importable wizard templates をチェックし

ます。 

↓ 

 

 

 

 

 

 

 

 

 

目的のプログラムをハイライトにし、Open をクリックします。 

↓ 

Method Builder の Main ダイアログが表示されます。 

Overview 画面にはメソッド全体の設定項目が表示されます。以下に変更項目について記載

します。詳細は Biacore T200 日本語取扱説明書 基本操作編を参照してください。 
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（Cycle Types） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sample コマンドの設定を変更します。Type を Double mix に変更し、Acid solution および

Neutralization soln の項目に、Double mix 時の推奨条件を入力します。 
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7-1-3. データ解析 

ウィザードもしくはメソッドを用いた測定プログラム終了後、Evaluation ソフトウェアは自

動的に立ち上がり、取得データは解析に向け移行します。 

 

 

補足 7-3. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 7-4. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

Sensorgram window 
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Toolbar の         をクリックし、          を選択します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

画面下部に、サイクルごとにおける結合量がプロットされます。赤色のプロットはコント

ロール、黒色のプロットはサンプルです。 

Settings 

Curve;   Fc=3 を選択します 

Report Point;  2 次抗体を利用して結合量を増幅している場合は、enhance_level 

2 次抗体を使用していない場合は、stability を選択します 

Regions&Boundaries 

Number of Regions; 評価基準の数を設定します 

Boundary;  評価基準となる数値を入力します 

Region Name;  評価基準に対するカテゴリーごとの名称を入力します 

Finish をクリックします。 

 

補足 7-5. コントロールサンプルによる結合量補正 

経時的にリガンドが失活する場合や、再生条件が不十分な場合には、サイクルごとにリガ

ンドの結合キャパシティーが低下しています。コントロールサンプルを定期的に測定して

いる場合には、コントロールサンプルの結合量低下が確認できます。この場合、結合量の

ランキングを正確に把握できません。正確なランキングを行うためには、コントロールサ

ンプルの結合量に基づき、リガンドの最大結合量を考慮し、結合量を補正します。 

Adjustment for Controls をクリックします。 
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↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adjustment settings 

Use adjustment for controls にチェックします 

Positive control;  利用するポジティブコントロールを選択します 

Negative control;  利用するネガティブコントロールを選択します 

Fitting function;  フィッティングに利用する式を選択します 

Linear（線形式）または Polynomial（多項式）を選択します 

 

ウインドウ右側に補正後のプロットが表示されます。ポジティブコントロールのフィッテ

ィングラインが Y 軸=100 で、ネガティブコントロールのフィッティングラインが Y 軸=0 で

表示されます。 

OK をクリックすると、補正後のプロットが表示されます。 

 

↓ 
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評価基準で設定した値にラインが引かれます。同時に、右表には、評価基準に対して属す

るカテゴリーの名称が、Ranking カラムに入力されます。上段のカラムをクリックすると、

昇順および降順の並び替えが可能です。 
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7-2. 阻害法を利用した ADAs の同定 

スクリーニングで陽性だったサンプルについて、阻害法によって ADAs の同定を行います。

サンプルおよびサンプルに薬物を混合した溶液を、薬物固定化表面に添加して、結合量の

低下の有無から ADAs を同定します。添加はダイレクト法を使用します。 

7-2-1. プログラムの実行 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run → Wizard をクリックしま

す。 

 

 

 

 

 

 

 

 

 

 

Immunogenicity → Immunogenicity Confirmation を選択した後、New をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

1サイクル分の測定シークエンスを設定します。Enhancementおよび Regenerationの回数は、

条件に合わせて設定します。Next をクリックします。 

↓ 
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ダミーランを設定します。ダミー用のサンプルは、ポジティブコントロールを用います。3

回以上の実施を推奨します。Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

測定直前に、サンプルに緩衝液または薬物を混合します。Sample 項目では、Cycles without 

drug には Buffer を、Cycles with drug には薬物名を入力します。Fraction では混合比率を入力

します。サンプル添加条件および再生条件を入力し、Next をクリックします。 

↓ 
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サンプル名を入力します。Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

コントロールサンプルを測定する場合は、Run control samples をチェックし、さらに繰り返

し測定する場合は、Run control sample(s) every をチェックします。測定頻度は、10 サンプル

もしくは 20 サンプル毎が推奨です。コントロールサンプル名を入力し、Next をクリックし

ます。 

↓ 
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測定の流れが表示されます。Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

Sample compartment temperature は 10℃を推奨します。ただし、10℃にすることで沈殿する

溶液もあるため、注意が必要です。（例；guanidine-HCl は 10℃で沈殿します。） 

最後に測定の流れを確認する場合は、Cycle Run List をクリックします。Next をクリックし

ます。 

↓ 
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右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。Next をクリックします。 

 

補足 7-6. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 
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基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。Start をクリッ

クします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

 ↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動して、各サイクルの測定結果が重ね書き表示されます。
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7-2-2. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

 

 

補足 7-7. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table…で変更します。Tools… → Keyword Table…をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 7-8. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

Sensorgram window 
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Toolbar の         をクリックし、             を選択します。 

 

 

 

 

 

 

 

 

 

 

 

ADAs を同定するためには、薬物を混合したときの結合量と、薬物を混合していないときの

結合量を比較する必要があります。それぞれのプロットデータを作成して比較をおこない

ます。 

上記画面では、左が薬物混合時のプロットデータ、右が薬物を混合していないときのプロ

ットデータです。それぞれ評価基準を設けます。 

 

Settings 

Curve;   評価するフローセルを選択します 

Report Point;  2 次抗体を利用して結合量を増幅している場合は、enhance_level 

2 次抗体を使用していない場合は、stability を選択します 

Show sample cycles mixed with;にて、薬物混合有り無しを選択します 

Regions&Boundaries 

Number of Regions; 評価基準の数を設定します 

Boundary;  評価基準となる数値を入力します 

Region Name;  評価基準に対するカテゴリーごとの名称を入力します 

   High および low を使用すると便利です 

 

コントロールサンプルによる結合量補正については、補足 7-5 を参照してください。 

Finish をクリックします。 

↓ 

 

 

 

 



 
 

182   7. 免疫原性試験  

Biacore T200 

日本語取扱説明書 

 

 

 

 

 

 

 

 

 

 

 

 

 

評価基準で設定した値にラインが引かれます。同時に、右表には、評価基準に対して属す

るカテゴリーの名称が、Ranking カラムに入力されます。上記画面は、薬物混合時の結果を

表していますので、low と表示されているサンプルが、評価対象となります。 

次に、薬物を混合していないときの結合量を評価します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

上記画面は、薬物を混合していないときの結果を表しています。high と表示されているサ

ンプルが、評価対象となります。 

薬物混合時の評価が low、薬物を混合していない時の評価が high のサンプルが、ADAs 陽性

サンプルです。 
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7-3. ADAs のアイソタイプの同定 

アイソタイプの同定は、サンプル添加後、引き続きアイソタイプを認識する抗体を添加し

て、結合の有無で判断します。 

7-3-1. プログラムの実行（Merged Inject 法の場合） 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run→Wizard をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Immunogenicity → Immunogenicity Isotyping を選択した後、New をクリックします。 

↓ 

 

 

 

 

 

 

Merged Inject 法を使用する場合は、○Acidification and neutralization にチェックします。

酸性化および中和をしない場合は、○Direct analysis にチェックします。Next をクリック

します。 

 

以降、○Direct analysis を用いて説明します。 

↓ 
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1 サイクル分の測定シークエンスを設定します。Use reagent(s) per cycle カラムから、アイソ

タイプを同定するための抗体の数を選択します。Regeneration の回数は、条件に合わせて設

定します。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

ダミーランを設定します。3 回以上の実施を推奨します。Next をクリックします。 

↓ 
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それぞれの項目における溶液名、添加時間、流速を入力します。（Merged Inject 法を最初に

選択している場合は、Sample 画面に、Acidification solution カラムと、Neutralization solution

カラムが表示されます。） 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

サンプル名を入力します。 

Next をクリックします。 

↓ 
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アイソタイプ同定のための抗体名を入力します。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

測定の流れが表示されます。 

Next をクリックします。 

↓ 
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Analysis temperature および Sample compartment temperature を設定します。Analysis 

temperature および Sample compartment temperature は 10℃を推奨します。ただし、10℃に

することで沈殿する溶液もあるため、注意が必要です。（例；guanidine-HCl は 10℃で沈殿し

ます。）最後に測定の流れを確認する場合は、Cycle Run List をクリックします。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 
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補足 7-9. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。Start をクリッ

クします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

 ↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動して、各サイクルの測定結果が重ね書き表示されます。 
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7-3-2. プログラムの実行（Double Mix 法の場合） 

7-3-1 章に従い、Immunogenicity Isotyping ウィザードを用いてプログラムを作成し、保存し

ます。保存したウィザードを用いて、メソッドによりプログラム内容を変更します。 

Toolbar の Run Method アイコン（  ）または Menu bar の Run→Method をクリックしま

す。 

↓ 

 

 

 

 

 

 

 

 

 

ウィザードを保存したフォルダを指定し、Show importable wizard templates をチェックしま

す。 

↓ 

 

 

 

 

 

 

 

 

 

目的のプログラムをハイライトにし、Open をクリックします。 

↓ 

Method Builder の Main ダイアログが表示されます。 

Overview 画面にはメソッド全体の設定項目が表示されます。以下に変更項目について記載

します。詳細は BiacoreT200 日本語取扱説明書 基本操作編を参照してください。 
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（Cycle Types） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sample コマンドの設定を変更します。Type を Double mix に変更し、Acid solution および

Neutralization soln の項目に、Double mix 時の推奨条件を入力します。 

↓ 

 

2 次抗体添加のコマンドを追加します。Enhancement コマンドを２次抗体の数だけ追加して、

詳細条件を入力してください。 
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7-3-3. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

 

 

補足 7-10. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 7-11. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

Sensorgram window 
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Toolbar の         をクリックし、          を選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Curve;  目的のフローセルを選択します 

Sample Cut-Off; サンプル結合量の Cut-Off 値を入力します 

棒グラフは、2 次抗体の結合レスポンスを表示しています。上記画面では、抗 IgM 抗体が赤

色、抗 IgG 抗体が緑色で表示されています。それぞれの結合レスポンスにおける Cut-Off 値

を画面下のテーブルに入力し、Finish をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

サンプル結合量が Cut-off 値を超えているサンプルが抽出されて、２次抗体の結合量が棒グ

ラフで表示されます。また、２次抗体について Cut-off 値を超えている場合は、テーブルの

数値が緑色で表示されます。 
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7-4. ADAs の成熟度の確認 

一般的に、ADAs の成熟度の確認方法として、ADAs のアフィニティーを評価します。しか

し、ADAs の正確なモル濃度が分からない場合は、カイネティクス解析およびアフィニティ

ー解析は不可能です。このため、濃度情報が反映されない解離領域から、薬物に対する ADAs

の結合量の半減期を算出することで、ADAs の成熟度を評価します。 

7-4-1. プログラムの実行 

Toolbar の Run Wizard アイコン（  ）または Menu bar の Run→Wizard をクリックします。 

 

専用のウィザードがないため、Screening ウィザードを使用します。 

Immunogenicity → Immunogenicity Screening を選択した後、New をクリックします。 

↓ 

 

 

 

 

 

○Direct analysis にチェックします。成熟度の評価では、Merged Inject は使用しません。 

Next をクリックします。 

↓ 

 

 



 
 

7. 免疫原性試験   195 

 

Biacore T200 

日本語取扱説明書 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1サイクル分の測定シークエンスを設定します。Enhancementおよび Regenerationの回数は、

条件に合わせて設定します。Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

ダミーランを設定します。3 回以上の実施を推奨します。Next をクリックします。 

↓ 
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それぞれの項目における溶液名、添加時間、流速を入力します。サンプルの解離時間は、

解離領域をカーブフィッティングさせるため、120 秒以上設定してください。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

サンプル名を入力します。Run order を設定し、Next をクリックします。 

↓ 
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コントロールサンプルを測定する場合は、Run control samples をチェックし、さらに繰り返

し測定する場合は、Run control sample(s) every をチェックします。 

Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

Analysis temperature および Sample compartment temperature の温度を設定します。Sample 

compartment temperature の温度は 10℃を推奨しますが、10℃で沈殿する溶液もあるため、

注意が必要です。（例；guanidine-HCl は 10℃で沈殿します。）最後に測定の流れを確認する

場合は、Cycle Run List をクリックします。 

Next >をクリックします。 

↓ 
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右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 

 

補足 7-12. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu→Export Positions を

実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を変

更した後ファイルを保存し、Menu→Sample Position Import でそのファイルを読み込むと、

サンプル位置が変更されます。 
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基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。Start をクリッ

クします。 

↓ 

設定したウィザードをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォル

ダに保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

 ↓ 

測定終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動に保存され、Biacore T200 Evaluation Software が自

動的に起動して、各サイクルの測定結果が重ね書き表示されます。
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7-4-2. データ解析 

ウィザードもしくはメソッドを用いた測定プログラム終了後、Evaluation ソフトウェアは自

動的に立ち上がり、取得データは解析に向け移行します。 

 

 

補足 7-13. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools→Keyword Table をクリックします。 

リガンド名の変更は、右下の Edit Chip Information をクリックして変更します。 
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補足 7-14. 画面の説明 

Menubar 

Toolbar 

 

 

 

Evaluation Explorer 

Work area 

 

 

 

 

 

 

 

Menubar    すべての作業コマンドを含む各種メニュー表示 

Toolbar    使用頻度の高い作業コマンドをアイコン化して表示 

Evaluation Explorer  すべての測定データ、解析後のデータの表示 

Sensorgram  測定により取得したセンサーグラム 

Plot   測定時に取得したレポートポイント名別のプロット 

Baseline     サンプル添加直前の AbsResp 

Binding level     サンプル添加時の Baseline からの RelResp 

Binding stability    サンプル添加直後の Baseline からの RelResp 

Binding to reference   リファレンスセルに対する Binding level 

Work area   Evaluation Explorer で選択したファイルを表示 

 

Sensorgram window 
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Toolbar の         をクリックし、         を選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ここでは、結合量ランキングのための設定をおこないます。 

Settings 

Curve;   評価するフローセルを選択します 

Report Point;  stability を選択します 

Response Type;  Relative Response を選択します 

 

Regions&Boundaries 

Number of Regions; 評価基準の数を設定します 

Boundary;  評価基準となる数値を入力します 

Region Name;  評価基準に対するカテゴリーごとの名称を入力します 

Next をクリックします。 

↓ 
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全画面で設定した評価基準値以上の結合量のサンプルについて、解析結果が画面下のテー

ブルに表示されます。評価基準の最小値より小さいと評価されたサンプルに関しては、自

動的に解析から除外されます。画面上には、各サイクルの Slow Fraction（%）がプロットさ

れています。解析モデルの詳細は、補足 7-15 を参照ください。 

 

RelResp Tot (RU);  解離直後の結合レスポンス 

Fast Fraction (%);  全結合抗体に対する解離が速い抗体の割合 

Slow Fraction (%);  全結合抗体に対する解離が遅い抗体の割合 

t1/2 Fast (s);  解離が速い抗体の半減期 

t1/2 Slow (s);  解離が遅い抗体の半減期 

 

プロットデータ上部のスライダーでは、プロットに表示される Slow Fraction の t1/2の下限値

の設定ができます。入力した時間（上記画面の場合 10 秒）より t1/2が長いサンプルが、プ

ロットデータに反映されます。Plot settings で表示方法を変更することが可能です。 

Finish をクリックします。 
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補足 7-15. 解離領域の反応モデル式および半減期の計算方法 

免疫応答において産生される抗体は、カイネティクスプロパティが異なる抗体が混在して

いることが予測されます。しかし、既存の反応モデル式では、混在している個々の抗体を

評価することができません。そのため、抗体の成熟度試験では、2 つの独立した解離成分を

含んだ解離反応モデル（two-component model）を使用して、解離領域のみを解析すること

で評価します。 

ただし、このモデルは 2 つの明確に異なる抗体が存在することを証明するものではなく、

あくまでも、速い解離の抗体、遅い解離の抗体の優位性の観点から、免疫応答を分類する

ための評価ツールです。 

解離領域におけるカーブフィッティングのモデル式は次の通りです。 

R = R1 x e-kd1 ( t - t0 ) + R2 x e-kd2 ( t - t0 ) 

R; t (s)における結合レスポンス   kd1および kd2; 解離速度定数    

R1および R2; kd1および kd2を求める際の解離領域開始レスポンス 

また、t1/2（半減期）の計算式は、下記になります。t1/2は、複合体の量（抗体結合量）が 50%

低減するのに必要な時間（秒）です。 

t1/2 = ln2 / kd  
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■総合お問合せ窓口 
 

TEL : 03-5331-9336 
 

● 機器アフターサービス 

（営業日の 9:00～17:30、音声案内に従い①を選択） 

FAX : 03-5331-9324（常時受付） 

● 製品技術情報に関して 

（バイオダイレクトライン、営業日の 9:00～12:00、13:00～17:30） 

音声案内に従い②を選択後、対象の製品別の番号を押してください。 

❶：ÄKTA、クロマトグラフィー関連製品 

❷：ビアコア関連製品 

❸：電気泳動関連製品、画像解析装置 

❹：IN Cell Analyzer、ワットマン製品、その他製品 

e-mail : Tech-JP@cytiva.com（常時受付） 

● 納期／在庫お問合せ 

（営業日の 9:00～12:00、13:00～17:30、音声案内に従い③を選択） 

 

注）お問合せに際してお客さまよりいただいた情報は、お客さまへの回答、弊社サービスの向上、

弊社からのご連絡のために利用させていただく場合があります。 

注）アナログ回線等で番号選択ができない場合はそのままお待ちください。オペレーターにつな

がります。 

 

www.cytivalifesciences.co.jp 
 

論文に掲載いただく際の名称・所在地 

Cytiva 
Tokyo, Japan 
 
 

グローバルライフサイエンステクノロジーズ      

ジャパン株式会社 

〒169-0073 

東京都新宿区百人町 3-25-1 サンケンビルヂン

グ 

お問合せ：バイオダイレクトライン 

TEL : 03-5331-9336 
e-mail : Tech-JP@cytiva.com 

掲載されている内容は 2019年 4月現在のもので予

告なく変更される場合がありますのであらかじめ

ご了承ください。掲載されている社名や製品名は、

各社の商標または登録商標です。お問い合わせに

際してお客さまよりいただいた情報は、お客さま

への回答、弊社サービスの向上、弊社からのご連

絡のために利用させていただく場合があります。 

 


